
 

PDS DioView  
 

Installation Guide  

This document lists the installation instructions for the PDS DioView Version 5.5 update. Once you have verified 

that your computer meets the system requirements, you can install the update. 

  

Single Install or Network Configuration 

If your institution uses only one installation of a PDS product and you store your PDS data on that same 

computer, skip to the Installation Instructions section. 

If you have one or more computers using data stored on a separate computer, you need to "point" those 

computers to the shared database using the instructions below. 

 

To set up a shared network database on a server: 

1. On the computer (server) that you want to store your database, open Windows Explorer. 

2. Locate the computer in My Network Places, and note how its name displays. You need this when 

configuring workstations to access the shared data. 

3. Create a folder on the server's hard drive, and give it a name associated with the program. For example, 

"PDS Data". 

4. Right-click the folder, and select Sharing and Security. 

5. On the Sharing tab, select Share this folder. Note the Share name, as it's needed when configuring 

workstations to access the shared data. 

6. Click Permissions. In Permissions for Everyone, select all check boxes in the Allow column. 

7. Click OK on both dialog boxes. 

In Windows Explorer, the folder displays with the "shared" attribute. 

 

After these steps, your PDS program can be installed on the server as described in the Installation Instructions 

section below. When prompted for the data location, enter the network path to the server data directory. You can 

use either the server’s UNC name (\\server\share\file_path) or a drive letter (if you first mapped the data directory 

to a drive in Windows Explorer). 

 

Once your program is installed, you can easily find out where it stores and retrieves its data. Right-click the 

desktop shortcut icon and select Properties. In the Target field, note the string D=”<path>. 

 

  



 

Installation Instructions 

In order to In order to download PDS programs online, you must be enrolled in the Preferred Client Program. 

 

To download your update online: 

1. Go to the PDS Downloads page in the PDS Client Portal. 

2. Locate and click DioView 5 Update. 

3. Click Download, then save the file to your desktop. 

4. On your desktop, double-click the DioView .exe file. 

5. In the Setup wizard, click Next. 

6. Select the folder where you want to install the update and data files. The folder paths cannot exceed 60 

characters in length. 

7. Click Next. 

8. After the installation is complete, click Finish. 

9. Return to your desktop. Double-click the icon to open the program and follow the on-screen instructions. 

 

To install your program from a CD: 

1. Insert the installation CD in your computer's CD drive. The PDS DioView window displays. If the 

installation window doesn't open automatically, locate the Setup.exe file on the CD, and double-click to 

start it. 

2. Click the link for the PDS Diocesan View program. 

3. Under Install the Program on This Computer, click Setup. 

4. Click Next. 

5. Read the License Agreement. If you accept the terms of the agreement, select I Accept the EULA 

Terms and click Next. 

6. Select the folders where you want to install the program and data files. The folder paths cannot exceed 

60 characters in length. 

7. Click Next. 

8. After the installation is complete, click Finish. 

9. Return to the menu of your choice, or exit the installer. 

10. Return to your desktop. Double-click the icon to open the program and follow the on-screen instructions. 

 

If you have multiple workstations, all computers must be upgraded at the same time.  

https://links.acstechnologies.com/go.acs?id=3500
https://links.acstechnologies.com/go.acs?id=4200


 

DioView 5 User Guide 

The PDS DioView User Guide contains the following sections. Click a section title below or use the navigation 

menu. 

 

Getting Started 

Get started with your DioView program. Learn about the basic features, how to navigate within the program, and 

how to customize the program to suit your needs. 

 

Churches and Institutions 

View information about every church and institution that you receive data from. 

 

Master List of Accounts 

The master list of accounts is your diocesan chart of accounts (COA). You can edit, view, and print reports on the 

account sums for all your churches and institutions. 

 

Processes 

At the end of the fiscal year, you can run your financial reports and close all monthly and yearly transactions. 

 

Reports 

Create and print reports, letters, envelopes, and more. You can also learn how to use the Selection window, and 

manage report styles and settings. 

  



 

Getting Started 

This section contains information on operating the program, descriptions of selections on the ribbon, and other 

basic features. Learn how to print a screen, use a calculator, and look at a yearly calendar. 

You can also read key information about customizing your view and navigating the program, as well as additional 

information about program, network, and printer support. 

 

The Menus 

The menus referenced in this guide are located across the top of the program. Each menu item opens to display a 

drop-down list of related items. 

 File — Lists all the main menus that display to the left of the program window, along with license 

information, screen information, program summary, user activity log, and the list of users in the program. 

You can also get to the calculator, year-at-a-glance calendar, and print screen options. 

 Edit — Has commands for editing fields in the active window, such as Undo, Cut/Copy/Paste/Delete, 

Select All, and Spell Check. 

 Keywords/Tables — Displays the keyword lists and tables. Click a menu item to edit keywords. 

 System Processes — Lists options for system processes, such as setting initial program options, 

formatting account numbers, and ensuring churches have all accounts. 

 Backup/Restore — Has options for backing up and restoring data. 

 Test/Fix — Displays options for testing the program and fixing damaged data. 

 Online Resources — Lists helpful resources that you can use. 

 Help — Gives several locations where you can find information about your program. 

    

The main menu displays to the left of the Home window. 

 Churches and Institutions — See Churches and Institutions. 

 Master List of Accounts — See Master List of Accounts. 

 Complete COA — See Complete COA. 

 Processes — See Processes. 

 COA Groups — See COA Groups. 

 Reports — See Reports. 

 Users/Passwords — See Users and Passwords. 

 Exit — Closes the program. 

  

Keyboard Shortcuts 

You can use keyboard shortcuts to quickly navigate through your PDS program. 

When you press Alt on your keyboard, notice the letters that display above each tab. Press Alt and then the letter 

of the section you want to go to. Use the arrow keys to navigate drop-down lists and menu items. Press Enter to 

select a highlighted menu item. 

You can perform actions in the program using the following key combinations. 

Key Combination Action 

Ctrl + C Copies the selected text 

Ctrl + K Opens the calculator 

Ctrl + P Prints the current window 

Ctrl + V Pastes the copied or cut text 

Ctrl + X Cuts the selected text 

Ctrl + Y Opens the Year at a Glance calendar 



 

Ctrl + Z Reverts your last edit 

Alt + down arrow Opens a drop-down list 

Alt + F4 Closes the active window 

   

You can navigate the program using the following keyboard shortcuts. 

Navigation Keys Moves Insertion Point Ctrl + Key Moves 

Left arrow Left one character or unit Left one word or larger unit 

Right arrow Right one character or unit Right one word or larger unit 

Up arrow Up one line or unit Up one larger unit 

Down arrow Down one line or unit Down one larger unit 

Home Beginning of line Beginning of data 

End End of line End of data 

Tab Next field --- 

Shift + Tab Reverse tab order --- 

PgUp Up one window at a time --- 

PgDn Down one window at a time --- 

 

 

Locating a Record 

To locate a particular record, use the navigation tools at the bottom of the following windows: Churches and 

Institutions, Master List of Accounts, Complete COA, COA Groups, and Users/Passwords. 

 

You can search for a single record based on name, ID, number, and so on. Or you can scroll through each record 

until you see the one you want. 

 

To search for a specific record: 

1. In a window with this feature, locate the navigation tools. 

2. Click Quick Lookup. 

3. Begin entering the name, ID number, or email address of the record you want to locate. Alternatively, 

click the drop-down arrow on the right side of the field and select a record. 

4. Once you enter the correct value, click Lookup/OK to display the record. 

 

To scroll through the records: 

1. In a window with this feature, locate the navigation tools. 

2. Click the Order by drop-down list and select a method of organizing the records. If, for instance, you 

select to order by name, you can scroll through the records alphabetically based on names. The Order by 

selections options differ depending on the window being used. 

3. Click the inner arrows  to move to the previous or next record. 

4. Click the outer arrows  to move to the first or last record. 

 

 



 

Customizing Text and Sounds 

To customize your program's text and sounds, click File > Screen Information. 

You can customize the following special effects in your program: 

 Show Animation on Welcome Screen — When selected, the Welcome window moves slowly to the 

right to reveal the main menu. 

 Fade Text on Screens that are Not Active — When selected, inactive windows located behind active 

windows are faded. 

 Sound When Messages Pop Up — Messages display for specific activities such as entering a duplicate 

ID, selecting the Inactive check box, or displaying error messages. To select a sound, click the Sound 

when Messages Pop Up drop-down list. Next, click an option in the list. To preview the sound, click 

Test. 

  

Customizing Program Colors 

To customize your program colors, on the File menu, click Screen Information. 

You can select one of the preexisting color schemes from the Color Scheme drop-down list, or you can create 

your own. 

Select the Few Colors color scheme if your computer has 256 colors available. 

To set up your own color scheme: 

1. On the File menu, click Screen Information. 

2. Click Adjust Colors. 

3. Click Add New Color Scheme. 

4. You can change the colors for various parts of your program windows. A preview of your changes 

displays at the right. 

5. When you're finished, click Save/OK. 

6. In the Screen Information dialog box, click Save/OK. 

   

 

Additional Field Information 

 
Start/End Color — Click the drop-down lists to select coordinating colors. Preview the new colors in the pane to 
the right. 

Find Color — Select a custom color. 

Hue/Saturation/Lumination — Adjust these controls to change the colors within the scheme. Hue refers to the 
gradation of color within a visible spectrum. Saturation refers to the intensity of the color. Lumination refers to 
the amount of lightness or darkness of the color. 

Red/Green/Blue — Adjust these controls to add more or less of each color to the scheme. 

Menu Text Color — Adjusts the color of the selected item on a menu. 

Selected Color — Adjust the color of the selected item in a window. 

1st. Bar Color/2nd. Bar Color — Click the drop-down list to alternate grid colors.  



 

Changing Window Size 

You can adjust your program's window size to accommodate old monitors. Click and drag the corners of the 

window to resize it. Or, to specify a size, on the File menu, click Screen Information. 

 Set to Minimum Size — Reduces the screen resolution to 640 pixels by 480 pixels, or the minimum size 

your monitor fits. 

 Set to Maximum Size — Enlarges the screen resolution to the maximum size your monitor fits. 

  

Viewing License, Registration, and Dealer Information 

You can view and edit information about your program license, your registration, and your dealer. To locate this 

information, on the File menu, click License Information. 

If you contact PDS Customer Support, have your site number or registration code available. 

 

Registration Information 

The Registration Information tab displays the licensee name, site number, and registration code, along with your 

organization’s address and other contact information. 

 

Dealer Information (Optional) 

The Dealer Information tab displays contact information for the dealer who sold your program to you. If your 

dealer provided a data file at the time of purchase, you can import the dealer information. Click Import Dealer. 

Browse to the Dealer.ini file and click Open. 

 

Program Summary 

The program summary includes information such as the program version, the date the program was first run, the 

last backup date, and the date of the last data fix. You can also view the number of accounts. 

On the File menu, click Program Summary. 

 

Viewing User Activity  
 

Log of User Activity 

The Log of User Activity displays the date, time, and user name associated with activities performed or entries 

made in the program. If the program administrator doesn't require a user name to enter the program, "PDS User" 

is recorded for the name. 

On the File menu, click View Log of User Activity. To reorder the log, click Order By and select a column 

heading. To print a report of activity, click Log Report. 

Administrators can click Delete Log Entries to delete items that occurred before a specified date. In the Delete 

Entries Before field, enter a cut-off date, or click the calendar icon to select a date. All entries prior to the date 

entered are deleted when you click Yes. 

 

List of Users Currently in the Program 

You can view a list of users currently in the program and the name of the computer they are using. You can use 

this feature when other network users are working in the program and preventing you from performing a task, 

such as a backup. On the File menu, click List of Users Currently in Program.  



 

Additional Field Information 

Warning 

If you need to change the fiscal year after your initial setup, it may affect your beginning balances.  

In some cases, beginning balances cannot be recalculated for the new fiscal year. Review all  

beginning balances if you change the fiscal year here. 

Customizing the Program 

You can customize program settings and create lists to store information for your organization. These settings are 

saved in three different ways: 

All users on the network share the following settings: 

 License information, such as the name and address of the organization 

 Security method, including passwords and user names 

 Automatic backup options, such as the drive letter, and automatic backup settings 

 Report information, which is saved individually for each report, including report names and descriptions 

The following settings are saved on each computer: 

 Screen settings 

 Grid settings 

 Report settings, including the printer, paper size, paper source, orientation, letterhead style, margin, and 

gray heading 

 Auto-spell in the report editor 

 Show paragraph and space markers in the report editor 

The following settings are saved to each user's name: 

 User names, passwords, and access privileges, including security administrator access 

 Use the name breakdown method to enter names 

 

Setting Initial Program Options 

In the Initial Setup window, you can specify various program options and preferences. On the System Processes 

menu, click Initial Setup. Base your initial setup selections on your fiscal year, accounting policies, and the 

program features you want to use. 

 

 

 

 

 

 

 

Current Fiscal Year Begins 

Enter the starting date of the current fiscal year. 

Accounting Approach 

By default, Cash Basis is selected. 

 Cash Basis accounting is the most common method of accounting. You pay expenses directly from Cash 

in the same period you receive an invoice, and you record income directly to Cash in the same period 

money is received. 

 Accrual Basis accounting records invoices as Accounts Payable when they're received. Money is 

removed from Cash when you pay them. You record deposits as Accounts Receivable when the money is 

promised to you, and then move money to Cash when it's received. 

Use Budgets 

By default, Yes is selected. If you select No, the Budget tab does not display in the COA Detail window, and there 

are fewer options in the Comparatives window under COA Detail. 



 

Use Master/Sub Accounts 

For new users, No is selected by default. If you're upgrading and had mater accounts and subaccounts 

previously, Yes is selected by default. Master and subaccounts reduce the number of accounts that print on the 

balance sheet and income statement. 

Require 'Allow Changes' on COA 

If you select Yes, the Allow Changes button is added to the chart of accounts windows. This locks the COA 

windows from editing to prevent accidental changes. You must click Allow Changes to temporarily unlock the 

COA windows each time you want to edit information. 

Use Sum of Nets 

Select Yes to display the Sum of Nets option. This account type option totals all Net Profit/Loss accounts. 

Set Parish Ledger Access 

Select Yes to display the user roles in parish ledgers. For more information, see Setting Up and Assigning Roles 

for Parish Ledgers. 

Allow Multiple Retained Earnings and Prior Year Fund Balances 

Select Yes to use multiple retained earnings and prior year fund balances with retained earnings, income, and 

expense accounts. 

Path to PDS Ledger Program 

Enter the location of the folder where the PDSLedger.exe file is located. This way, you can view the Ledger data 

of a synchronized parish. To enter each parish's Ledger data path, see the Password tab under Church/Inst Detail 

Subtabs. 

 

 

Formatting Account Numbers 

Before you can set up the chart of accounts, you need to establish a format for account numbers. 

On the System Processes menu, click Account Number > Account Number Format. In the Account Number 

Format window, you can customize account number prefixes, parts, and widths. You can format account numbers 

to include up to 20 characters with several parts. 

 
 

Adding a Part 

You can customize account numbers by adding parts, such as fund, organization, section, department, 

subdepartment, account, and suffix codes. 

To add a part: 

1. On the System Processes menu, click Account Number > Account Number Format. 

2. Click Add New Part. 

3. Click a location to place the new part in the account number. 

4. In the Type of Part drop-down list, select the account code. 

5. Set the width of the part. 

6. If necessary, add a separator. 

7. You can set this account number format without applying it to your existing account numbers. To 

change the format of account numbers that you enter in the future, select this option. To change the 

format of all account numbers, clear this option. 

8. To preview your new account number format, click View Proposed Changes. 

9. When you finish, click Save. 

Note 

Always back up your data before making changes to the account number format. 



 

Adding Fund Codes 

With fund codes, you can have multiple COAs with similar account numbers. The code typically displays at the 

beginning of an account number. Each COA must have a retained earnings account and a prior year fund balance 

account. Net income must be your last account. 

To add a fund code: 

1. On the System Processes menu, click Account Number > Account Number Format. 

2. Click Add New Part. 

3. Click Add Before Part 1. 

4. In the Part 1 Type of Part drop-down list, select Fund Code. 

5. Enter the width and separator. 

6. Clear the Skip transforming the chart of accounts option. 

7. To preview your settings, click View Proposed Changes. 

8. Click Save. The program updates the COA to reflect the changes. 

9. To enter each fund code, on the File menu, click System Processes > Account Number > Fund 

Codes. 

As an example, a list of account numbers display with the preceding fund codes in the following table. The fund 

codes let each set of accounts use the same range of numbers. Fund codes 1 and 2 display in the table. 

Account Number Account Name 

1-1000-1-1999 Church Assets 

1-2000-1-2999 Church Liabilities 

1-3000-1-3999 Church Income 

1-4000-1-4999 Church Expenses 

1-4999 Church Net Income 

2-1000-2-1999 Restricted Assets 

2-2000-2-2999 Restricted Liabilities 

2-3000-2-3999 Restricted Income 

2-4000-2-4999 Restricted Expenses 

2-4999 Restricted Net Income 

 

Adding Department Codes 

A department code lets you track multiple departments within one COA. A department code typically displays at 

the end of an account number. 

To add a department code: 

1. On the System Processes menu, click Account Number > Account Number Format. 

2. Click Add New Part. 

3. Click a location to place the new part in the account number. 

4. On the new part’s Type of Part drop-down list, select Department Code. 

5. Enter the width and separator. 

6. To display zeros for all department codes, select Skip transforming the chart of accounts. To format 

the accounts without zeros, clear the option. 

7. To preview your settings, click View Proposed Changes. 

8. Click Save. The program updates the COA to reflect the changes. 

9. To enter each department code, on the File menu, click System Processes > Account Number > 

Department Codes. 

 

 

 



 

As an example, the following table includes accounts for departments 01, 02, and 03. 

 

Account Number Department Name 

1010.01 Church Cash 

1010.02 Rectory Cash 

1010.03 School Cash 

3000.01 Church Income 

3000.02 Rectory Income 

3000.03 School Income 

4999 Net Income 

 

Deleting a Part 

You can delete any part of an account. However, as a result, you might create several accounts with the same 

account number. To avoid having duplicate account numbers, create unique numbers in the COA window. 

To delete a part: 

1. On the System Processes menu, click Account Number > Account Number Format. 

2. Click Delete Part. 

3. Click the appropriate button for the account you want to delete. 

4. Clear the Skip transforming the chart of accounts option. 

5. Click Save. The program updates the COA. 

The program retains the code listing with the code descriptions. 

Splitting a Part 

You can split account numbers into multiple parts. For example, your account number format includes a four-digit 

part. You want to change the first digit of that part to a stand-alone part. The new part must have a unique type. 

To split a part into two parts: 

1. On the System Processes menu, click Account Number > Account Number Format. 

2. Click Add New Part. 

3. Click a location to place the new part in the account number. 

4. On the new part’s Type of Part drop-down list, select a new type. 

5. Enter the width and separator. 

6. Select Skip transforming the chart of accounts. 

7. Click Save. The program applies the format but does not update the account numbers. 

8. To update account numbers with the new format, select Skip transforming the chart of accounts. 

9. Click Save. 

  



 

Transforming the COA 

The following table displays general operations and the effects on account number formatting if you clear the Skip 

transforming the chart of accounts option. 

 

Operation If the option is not selected Before After 

Add prefix Adds prefix to all account numbers. 1234-5 abc-1234-5 

Change prefix Changes prefix on all account numbers. abc-1234-5 xyz-1234-5 

Delete prefix Removes prefix from all account numbers. abc-1234-5 1234-5 

Add part (scenario a) 
Adds part, width, and separator to all account 
numbers. Displays zeros as placeholders. 

1234-5 

00-1234-5 
or 
1234-00-5 
or 
1234-5-00 

Add part (scenario b) 
Adds part, width, and separator to all account 
numbers. Displays zeros as placeholders. 

1234 

00-1234-00 
or 
1234-00-0 
or 
1234-0-00 

Change type of part 
(scenario a) 

Changes type, format, width, and separator on all 
account numbers. Displays zeros as placeholders. 

1234-5 1234-0 

Change type of part 
(scenario b) 

Changes type, format, width, and separator on all 
account numbers. Displays zeros as placeholders. 

1234 1234-0 

Delete part Deletes part in all account numbers. 1234-5 1234 

Increase width of part 
Displays the new width in all account numbers. 
Displays zeros as placeholders in the beginning of 
the part. 

1234-5 
01234-5 
or 
1234-05 

Decrease width of part 
Displays the new width in all account numbers. 
Removes digits from the beginning of the part. 
Removes digits from the beginning of the part. 

1234-5 234-5 

Add separator 
(scenario a) 

Changes accounts with digits in the part following 
the separator. 

12345 1234-5 

Add separator 
(scenario b) 

Changes accounts with no digits in the part 
following the separator. Displays zeros as 
placeholders at the beginning of the account 
number. Displays a separator in the middle of the 
first part. 

1234 0123-4 

Change separator Changes separator in all accounts 1234-5 1234/5 

Remove separator Removes separator from all accounts. 1234-5 12345 

 

 

Using Spell Check 

You can find and correct spelling errors in the text box, memo box, or report you're editing. On the Edit menu, 

click Spell Check. Or, right-click the field or report, and click Spell Check. 

If no spelling errors are found, the Information dialog box displays "Spell Check Complete." If Spell Check finds a 

possible error, it displays "Not Found", and you can replace the word. 

  



 

Additional Field Information 

Changing the View in a Listing Screen 

There are tabs labeled "View Listing" located on the following windows: Churches and Institutions, Master List of 

Accounts, Complete COA, and COA Groups. Depending on the window you're on, the tab displays relevant lists 

of church names, account numbers, account names, categories, report types, account types, and/or normal 

balances. 

All lists have a default view, but you can customize them to display the columns you want to see in the order you 

want to see them. 

 

To change settings, on the View Listing tab, click Customize View, and make your selections. See the Additional 

Field Information below for more on these options. To return to the default settings, click Default Values. 

 

Customizing the View 

 

 

Grid Properties 

 Number of lines per row — Increase this number to enlarge the height of each row in the grid. As you 

increase the number of lines in each row, you decrease the number of rows visible at a time. The default 

value is 1.00. 

 Font size of the grid — To use a larger font, increase the number. To make the font smaller, decrease 

the number. Increasing the size reduces the number of rows you see at a time. The default value is 8 pt. 

 Lock the first column — By default, this option is selected, and the column is locked. This keeps the 

column in sight when you scroll to the right of a list. To unlock the column clear this option. 

Fields 

You can use the drag and drop method or use the arrow buttons to move selected fields between the two lists. 

 Fields available to view — Contains the fields that are available to view in the listing grid. To add a field 

to the listing screen, click a field name. Then, click the right arrow to move the column to the Fields you 

want to view list. 

 Fields you want to view — Contains the fields displayed in the View Listing window. To display the width 

and heading name, click the field and the information displays below the list. Column headings display in 

the listing grid in the same order they are displayed in this list. To reorder the list, click the field name and 

drag and drop it to your preferred location in the list. Or, click the field name and use the up and down 

arrows to reorder the list. 

 Width — Displays the width of the selected item in the Fields you want to view list. In the listing screen, 

an ellipsis (...) displays at the end of an entry to signify you are seeing incomplete information. 

 Heading — Displays the column heading name. A column can never be sized smaller than its heading 

name. The smaller the columns, the more information you can see in the listing screen at a time. 

 

 

 

Useful Information 

If user names are required to enter the program, each user's customized view is saved. 



 

Getting Program Help 

To contact the Diocesan team, send a message to diosupport@parishdata.com. 

PDS Support 

To receive support and assistance with PDS products, you can visit the Client Portal or call us directly at 1877-

737-4457. Be ready to provide your site number and PIN, and make sure you have a valid support package. 

PDS Dealer Support 

If your program was purchased through a PDS dealer, your program support may be provided through them. To 

verify your support plan, contact your local PDS software dealer. 

Printers 

For assistance with your printer, contact the hardware representative or visit the printer manufacturer's website to 

download and install the latest printer drivers for your particular printer and model. We recommend using a tray-

fed laser or inkjet printer that is compatible with PDS System Requirements. 

  

https://links.acstechnologies.com/go.acs?id=3850


 

Users and Passwords 

You can set up credentials for any users who should have access to the program. 

 

Advantages of Restricting Program Access 

When this program is initially installed, anyone can view or change data. While requiring a user name and 

password to open the program is an optional feature, we recommend that you set up users with passwords to 

protect your data and avoid unauthorized changes. 

Several key advantages of requiring user names include: 

 Restricting who can enter your program. 

 Logging the user's name with the processes they performed. 

 Each user can define preferences for entering names in the program. 

 The administrator can see who's currently using the program. On the File menu, click List of Users 

Currently in the Program. 

Requiring passwords with user names: 

 Further restricts who can view your program data. A user name does not provide enough security to 

prevent someone from entering the program. 

 You can set which users can get to specific processes in program areas. 

Additionally, your PDS program automatically maintains a log of user activity whether or not user names are 

required to enter the program. 

 

Planning User Names and Passwords 

Before setting up users and passwords, you can print the User Access and Privilege form for each person in your 

organization. On the main menu, click Users and Passwords, then Print Worksheet. 

While planning, consider the following points: 

 Although it isn't required, we recommend that more than one user function as a security administrator. 

Security administrators should have a security setting of All Access to all program areas. 

 A user who's also a security administrator has the authority to assign, edit, and delete other users and 

their access privileges. 

 Users need a security setting of All Access or View Only Access to the Users and Passwords area in 

order to change their user name, password, or phone number, or to edit fields on the User Preferences 

tab. For example, users need to change the way they enters names in the program. Otherwise, a security 

administrator has to change it for them. 

 A user with a security setting of All Access to the Users and Passwords area can't open the Access and 

Privileges window unless the user is also a security administrator. 

 A security administrator can make changes to information in any User Detail window. 

 

Setting Up Users and Passwords 

After planning users and passwords, you can set up your organization's users in the program. 

To set up a new user with a password: 

1. On the main menu, click Users and Passwords. 

2. Click Add User. 

3. Enter the user information. For more, see the Additional Field Information below. 

4. When you're finished, click Save. 

  



 

Additional Field Information 

For each user you add, be sure to set access and privileges, and select user preferences. 

    

 

 

User Name 

The unique name a user enters when opening the program. This doesn't have to be the user's full name or real 

name. For example, Suzanne might want her user name to be "Susie" or "Sue". This is not case-sensitive. 

Inactive 

Inactivate a user account that you might reactivate at a later date. Inactive users can't log in. 

Password 

If you require users to have passwords to enter the program, enter it here. A password can be up to ten 

characters and can contain alphabetic, numeric characters, or a combination of both. Passwords are case-

sensitive. 

Security Adm. 

Select Yes to mark the user as a security administrator. At least one person must be the security administrator 

and have All Access to all program areas. This person is responsible for creating and maintaining all user 

accounts and resetting other users' forgotten passwords. For this reason, you should also have a backup 

administrator. 

Phone Number 

Enter a telephone number where this user can be reached outside of the office. Select Unlisted if this number 

shouldn't be shared with others. 

 

 

Assigning Access and Privileges 

 

Useful Information 

After program security is in place, a user name is required to enter the program, and only a security 

administrator with all access to the Users and Passwords window can make changes to this section.  

This is the easiest and most reliable way to safeguard your data. 

 

You can control access to each area of the program. As you select access privileges for each program category 

and its subcategories, note that a subcategory can have a more restrictive access level than its parent category. 

However, subcategories cannot have less restrictive access than parent categories. For example, a user can 

have all access to the Keywords/Tables program area but have no access or view only access to the Phone 

Descriptions area. 

1. From the main menu, click Users/Passwords. 

2. Locate the user you want to assign access to. 

3. Click the DioView Access Rights tab. 

4. For each program area listed, select an access option. See the Additional Field Information below for 

more on these options. 

5. If you use roles with PDS Ledger, click the Define Parish Ledger Roles tab, and select access options. 

6. Click Save. 

    

 

 



 

Additional Field Information 
 

No Access 

Users cannot access any windows, processes, and reports for the indicated program area. 

View Only Access 

Users can view windows and print reports related to the indicated program area. The user can use the navigation 

tools, but can't add or delete information. 

All Access 

Users can access all windows, processes, and reports for the indicated program area. 

      

Tip 

To give a user the same access to every program area, click Mark All No Access, Mark All View Only, 

or Mark All All Access. Then, if you want to allow or restrict access to a specific program area, you can 

select or clear those categories and subcategories. 

 

 

Setting Up and Assigning Roles for Parish Ledgers 

If your diocese has multiple parishes installed on one computer, you can authorize users from those parishes to 

access all databases. To do this, a role must be set up to identify users and access rights. DioView then applies 

the credentials to all parishes for use. 

Before you can set up parish roles, you must add a data synchronization password for each parish. 

To add data synchronization information: 

1. In the Churches and Institutions window, click Church/Inst. Detail. 

2. Locate the parish or facility you want to add information for. 

3. Click the Password tab. 

4. Enter the password for the parish's Ledger program. This way, DioView can push the new role(s) to 

each parish's copy of Ledger. 

5. If your diocese has all its parishes installed on one computer, each with its own copy of the Ledger 

program, enter the location of the parish's Ledger program files. 

6. Click Save. 

After you add passwords for each parish, you can set up and assign roles to users in your DioView program. 

Make sure you have enabled user roles in the program so you can see the role windows. 

To enable user roles: 

1. On the System Processes menu, click Initial Setup. 

2. Select Yes for Set Parish Ledger Access. 

3. Click Save, then Close. 

Add a security profile (user name and password) to use for all instances of the Ledger program. 

To set up roles: 

1. In the Users/Passwords window, click the Define Parish Ledger Roles tab. 

2. Click Add Role. 

3. Enter a role name. 

4. Select whether the role is considered a security administrator. 

5. Select whether to show outstanding invoices when the program starts. 

6. Select the program area(s) that users with the role can access. 

7. Click Save. 

If you change the parish role after assigning it to users, come back to this window and click Push Roles to 

Ledgers. 



 

You can copy a role you've already created. This way, if you just need to make a small change, you don't have to 

recreate the role from scratch. 

To copy an existing role: 

1. In the Users/Passwords window, click the Define Parish Ledger Roles tab. 

2. Click Copy Existing Role. 

3. Select a role to copy, and click Copy User. 

4. Make any necessary changes to the new role. 

5. Click Save. 

Once you set up roles in your program, you can assign them to specific diocesan users. This way, they can view 

Ledger data for selected parishes. 

To assign roles to users: 

1. In the Users/Passwords window, click the User Detail tab. 

2. Locate the user you want to assign a role to. 

3. Click the User Role in Parish Ledgers tab. 

4. In the grid, for each parish you want the user to view, select a role for the user. To assign a single role 

to all parishes for this user, click Assign a Role to All. 

5. Click Save, then click Push Roles to Ledgers. 

 

Changing the Way Users Enter Names 

Each user can select a preferred method for entering names in the program. 

Useful Information 

Remember, when set to All Access or View Only Access, a user can change his or her preferences. 

Otherwise, the security administrator must set up and maintain these for each user. 

 

To change the way names are entered: 

1. In the Users/Passwords window, click the User Detail tab. 

2. Locate the appropriate user. 

3. Click the User Preferences tab. 

4. Select a Name Breakdown option. See the Additional Field Information for more on these options. 

5. Click Save. 

  

Additional Field Information 

 

Enter name parts on separate lines 

This is the default option. When you begin entering a name, the Name Breakdown window automatically displays 

so you can enter the parts of the name: Last Name,  

First Name, Title, and Suffix. As parts of a name are entered on separate lines, the name formats for the Name, 

Mailing Name, Formal Salutation, and Informal Salutation are built. 

Enter entire name on a single line - automatically display dialog  

When you begin entering a name, the Name Breakdown window automatically displays. In the Name field, enter 

the last name, first name, title, and suffix. As you enter the entire name on the single line, the Mailing Name, 

Salutation, and the parts of the name (Last Name, First Name, Title, and Suffix), are filled in automatically. You 

can edit the name fields at any time. 

 

 



 

Enter entire name on a single line - do not automatically display dialog  

The Name Breakdown window doesn't automatically display. In any Name field, enter the last name, first name, 

title, and suffix. To verify the Name, Mailing Name, Formal Salutation, and Informal Salutation formats are correct, 

click the ellipsis icon (...) after the Name field.  

 

Copying an Existing User 

You can copy an existing user's Access Rights settings for a new user. You can do this if you have several users 

with similar roles. 

To copy access and privileges: 

1. In the Users/Passwords window, click the User Detail tab. 

2. Click Copy Existing User. 

3. Select the user you want to copy. 

4. Click Copy User. 

5. "Copy of [user name]" displays in the User Name field. Enter the new user name. 

6. Make any necessary changes for this user. 

7. Click Save. 

 

Setting the Security Method 

You can select the type of information users are asked for before entering the program. 

 

To set the security method: 

1. In the Users/Passwords window, click the User Detail tab. 

2. Click Set Security Method. 

3. Select a level of security. For more, see Additional Field Information below. 

4. Click Save/OK. 

 

  

Once security is set up, only a security administrator can change the method or disable program security. User 

information isn't affected if security is turned off. 

   

 

 

 

 

 

 

 

Note 

Before changing the default security method, make sure at least one user has a user name,  

password, and full access to the program. Ideally, this is a system administrator. 

Useful Information 

Changes to the security method do not take effect until you exit and restart the program. 



 

Additional Field Information  

None. The user is not asked for anything 

Disable program security. Existing settings in the User Detail, User Preferences, and Access and Privileges 

windows are not removed if program security is turned off. They display again if program security is reactivated. 

The user is asked for a name 

Keep a record of the user's name, but don't require the user to enter a password. The user must be set up on the 

User Detail window. 

The user is asked for both a name and a password 

Keep a record of the user's name, and require the user to enter a password to log in to the program. The user 

name and password must be set up on the User Detail window. 

The user name is detected by Windows authentication 

The PDS user name must match that used to log in to Windows®. On startup, if an active PDS user name 

matches somebody who is logged in to Windows, then the user can access PDS without additional prompting. 

Useful Information 

Only select this option if your network is secure, you trust the Windows login process, the computers are 

in reasonably secure locations, and you don't share passwords with others.  

 

 

Removing Users and Disabling Passwords 

Removing a User 

When an employee leaves your organization, we recommend removing the user's name and password from the 

program. 

To delete a user: 

1. In the Users/Passwords window, click the User Detail tab. 

2. Locate the user you want to delete. 

3. Click Delete User. 

4. Click Yes to delete the user. 

  

Disabling All Passwords 

Occasionally, a security administrator forgets the administrator password or some other emergency occurs, and 

you need to disable passwords to enter the program. Ideally, another security administrator can enter the program 

and reset the password. 

If this isn't an option, use the Rescue program on the installation CD. It contains an option to disable passwords. 

You can then enter the program, change the passwords, and enable user security again. Use the Rescue 

program as a last resort. 

 

 

 

 

 

 

 



 

Useful Information 

The Windows key is located to the left of the space bar. 

To disable passwords using the Rescue program: 

1. Insert the program CD into your CD-ROM drive. 

2. On your keyboard, hold the Windows® key and press R. 

 

 

 

 

3. Click Browse and locate X:\DioView\Rescue\ResqPDS.exe (where X is the drive letter of your 

CDROM). 

4. Click Open, and then click OK. 

5. When the Rescue program starts, click Next. 

6. If you have more than one PDS program installed on your computer, select the option that describes 

the program for which you need to unlock passwords. 

7. On the Disable Passwords tab, click Disable Passwords. Then click OK. The passwords are now 

disabled. 

You can enter the PDS program and reset passwords. To reset the passwords, on the main menu, select 

Users and Passwords. For more information, see Setting the Security Method. 

  



 

Additional Field Information 

Additional Field Information 

Churches and Institutions 

The Churches and Institutions window has information about every church and institution you receive data from. 

This includes financial data as well as church contact information, significant church events, and church statistics 

that you can monitor. 

Church/Inst Detail 

The Church/Inst Detail tab displays basic information about each church or institution in your database. It's 

organized into several tabs. You can add or delete churches and edit the records. 

For information about the subtabs in this window, see Church/Inst Detail Subtabs. 

To add a church or institution: 

1. In the Churches and Institutions window, click the Church/Inst. Detail tab. 

2. Click Add Church/Inst. 

3. Enter the name of the church. 

4. Enter a unique identification number or name for the church. 

5. Select Inactive if you want to remove the church listing from reports. 

6. In the subtabs, enter optional information about the church. 

7. When you finish, click Save. 

   

 

Order by 

Sorts accounts in the selected order. Click to select another sort order. 

Quick Lookup 

Search your records for a specific church by name or ID. The sort order of the list changes based on the selection 

you make in Quick Lookup. 

Data Transfer Details 

Set up the information to transfer from the selected church to DioView. Church accounts must be mapped to the 

diocesan accounts in order to transfer data. 

Ledger Detail 

Opens the PDS Ledger program and view current Ledger details. Before using this feature, enter the Ledger data 

path on the Password tab in the Church/Inst Detail Subtabs. 

 

View Listing 

The View Listing tab displays a list of groups. This information is for viewing purposes only. 

 

 

Order by 

Lists accounts in the selected order. To select another sort order, click this button. To navigate through the list, 

use the navigation arrow buttons. 

Customize View 

Customize the grid properties and fields that display. 

Quick Lookup 

Select a church by name or ID. The sort order of the list changes based on the selection you make in Quick 

Lookup. 



 

Additional Field Information 

Additional Field Information 

Print List 

Prints all active items in the list. 

Zoom 

View a full-screen display of the listing grid. To return to normal size, click Zoom again. 

 

Data Transfer 

The Data Transfer tab includes processes for transferring data from churches to DioView. You must set up your 

web service information on this tab before you can transfer data. 

To Do List 

When you first set up data transfer information, make sure you do the following in this order: 

 Enter your master list of accounts. 

 Enter all churches and institutions on the Church/Inst. Detail tab. 

 Enter a password on the Church/Inst Detail tab for each church. 

 Set up your web service information on the Data Transfer tab. 

 Upload the diocesan setup data to the DioView server. 

 When the church or institution uploads its data, download it from the server. 

 

 

 

Load in the Church Data 

Download the latest data from churches and institutions. This process retrieves data only from churches and 

institutions that use PDS Ledger, PDS Ledger/Payroll, or Intuit® QuickBooks® to upload data. 

Set up the Web Service Information 

Enter your web service information or test your web service connection. You must set up this information before 

you can load church data. Once the information has been entered, you don't have to enter it again unless there's 

a change to the server information. 

Update the Diocesan Setup Data 

Transfer information to the DioView server. This includes church IDs and passwords, the master list of accounts, 

and the settings selected on the Mapping Process Defaults tab in the Data Transfer Details window. You must run 

this process before you can upload data from churches and institutions. 

 

Church/Inst Reports 

The Reports tab displays a list of church reports available to print. To view the available reports, click the arrow 

beside the report heading. You can access all reports on the main menu. 

 

 
 

Add 

Add a report to the easy report list for the selected heading. 

Delete 

Remove the selected report that you added or copied. You can't remove predefined reports. 



 

Additional Field Information 

Copy 

Copy the selected report so that you can modify the original report without overwriting it. 

Reorder User Reports 

Customize the order of reports that you added or copied. 

Adv. Script 

Edit the programming for reports that you added or copied. This is an advanced process. 

Save as Custom Report 

Save the report you added or copied. 

View Sample 

Display a one-page sample of the selected report using your data. 

 

 

Church/Inst Detail Subtabs 

These tabs display on the Church/Inst. Detail tab in the Churches and Institutions window. 

Address 

The Address tab displays basic address information for the church or institution. You can also track the software 

used to maintain data. 

 

 

Institution Type 

Displays the type of the church or institution. If you have keywords set up, you can select one from the drop-down 

list. You can add new types to the keyword list by entering them here. 

Software Used 

Displays the account-management program that the church or institution uses. You can select PDS Ledger (PDS 

LED), PDS Ledger/Payroll (PDS LED/PR), a version of Intuit® QuickBooks® (QB 2003 or higher), or another 

program (Other). 

Map 

Displays a map of the address entered for the church or institution. The default map displays using Google 

Maps™. When the map displays, you can select a new mapping service by clicking Mapping Preferences. If you 

select Other, enter the web address of the mapping service you want to use, and click OK. To return to DioView, 

click the red X at the top right of the window. 

City/State 

Displays the city and state of the church or institution. When you select the field, the default city and state display. 

If you have keywords set up, you can select one from the drop-down list. You can add new types to the keyword 

list by entering them in this field. 

Region 

Displays the region for the church or institution. If you have keywords set up, you can select one from the drop-

down list. You can add new types to the keyword list by entering them in this field. 

General Size 

Displays the approximate population size for the church or institution. 

Language 

Displays the predominant language spoken at the church or institution. If you have keywords set up, you can 

select one from the drop-down list. You can add new types to the keyword list by entering them here. 



 

Additional Field Information 

Additional Field Information 

E-Mail 

Displays the email address for the church or institution. To send an email using your default email program, click 

the email icon.  

Web Site 

Displays the web address for the church or institution. If you enter a web address, include only the part after 

"http://". For example, if the web address is "http://www.church.com/", enter only www.church.com. To view the 

website in your default browser, click the browser icon . 

Phones 

Displays phone numbers for the church or institution. In the Description column, enter the type of phone number. 

In the Unl. column, select the check box for each unlisted number. 

Reorder 

Arrange the phone numbers in a particular order. Select a phone number and use the arrow buttons to move it in 

the list. 

 

Mailing Addr. 

The Mailing Addr tab displays the mailing address for the church or institution if it's different from the information 

entered on the Address tab. 
 

 

 

Address 

Displays the mailing address for the church or institution. 

City/State 

Displays the mailing city and state of the church or institution. If you have keywords set up, you can select one 

from the drop-down list. You can add new types to the keyword list by entering them in this field. 

 

Contacts 

The Contacts tab displays contact information for representatives of the church or institution. You can add a 

primary contact and any additional contacts. 

 

 

Contact 

To enter more information, such as the fields below, click the ellipsis icon (...). 

 Name — Contact's name as it displays in the program and on reports. 

 Mailing Name — Contact's name as it displays on mailings. 

 Salutation — Contact's name as it displays on salutations in letters and statements. 

 Recalculate — Reset the mailing name or salutation to the original program-generated format. 

Position 

The employment position of the contact. If you have keywords set up, you can select one from the drop-down 

list. You can add new types to the keyword list by entering them in this field. 

Map 

Display a map of the address entered for the contact. The default map displays using Google Maps™. When the 

map displays, you can select a new mapping service by clicking Mapping Preferences. If you select Other, enter 



 

Additional Field Information 

the web address of the mapping service you want to use, and click OK. To return to DioView, click the red X at 

the top right of the window. 

City/State 

The city and state of the contact. When you select the field, the default city and state display. If you 

have keywords set up, you can select one from the drop-down list. You can add new types to the keyword list by 

entering them in this field. 

Language 

The predominant language spoken by the contact. If you have keywords set up, you can select one from the drop-

down list. You can add new types to the keyword list by entering them in this field. 

E-Mail 

The email address for the contact. To send an email to this person using your default email program, click the 

email icon. 

Phones 

The phone numbers for the contact. In the Description column, enter the type of phone number. In 

the Unl. column, select the check box for each unlisted number. 

Reorder 

Arrange the phone numbers in a particular order. Select a phone number and use the arrow buttons to organize it 

in the list. 

Other Contact Tabs 

Display contact information for additional contacts for the church or institution. Click the tab at the bottom to 

display the contact information. 

Reorder 

Arrange contacts in a particular order. Select a contact and use the up and down arrow buttons to organize it in 

the list. The first contact in the list is the primary contact. To arrange contacts alphabetically, click Sort. 

 

Comments 

The Comments tab displays notes about the church or institution. 

To enter comments, click the Comments field and enter your notes. When you finish, click Save. 

Keywords 

The Keywords tab displays miscellaneous keywords for the church or institution. You can select keywords from 

the Keywords/Tables menu or add keywords as necessary. 

 

 

Insert 

Insert a new keyword description. 

Line Delete 

Remove the selected keyword from the church or institution. 

Reorder 

Arrange descriptions in a particular order. Select a keyword and use the arrow buttons to organize it in the list. To 

arrange keywords alphabetically, click Sort. 

 

 

 



 

Additional Field Information 

Additional Field Information 

Additional Field Information 

Documents 

The Documents tab displays names and locations of files associated with the church or institution. You can 

document multiple files. 

 

 

Insert 

Insert new document information for the church or institution. In the Date column, enter the date, or click the 

calendar icon to select a date. In the Description column, enter a description of the file. In the Filename column, 

enter the path and name of the file, or click the folder icon to select the file. 

Line Delete 

Remove the selected document information from the church or institution. 

 

History Log 

The History Log tab displays dates and descriptions of the church/institution's events. 

 

 

Insert 

Insert new event information for the church or institution. In the Date column, enter the date, or click the calendar 

icon to select a date. In the Description column, enter a description of the event. 

Line Delete 

Remove the selected event information from the church or institution. 

 

Statistics 

The Statistics tab displays the church/institution's statistical information based on keywords you select. 

 

 

Insert 

Insert new statistical information for the church or institution. In the Period column, enter the time period select a 

date. In the Statistic column, enter the type of the statistic you want to record. In the Count column, enter the 

value of the statistic. 

Line Delete 

Remove the selected event information from the church or institution. 

 

Chart of Acct. 

The Chart of Acct tab displays the chart of accounts (COA) for the church or institution. You can obtain a 

church/institution's COA on the Data Transfer tab. You can also map accounts in the church/institution COA to 

accounts in the diocesan COA. You can only view the information on this tab, but you can add your diocesan 

accounts to the COA account listing. 

To add accounts to the selected church or institution: 

1. On the Churches and Institutions window, click the Church/Inst. Detail tab. 

2. Click the Chart of Acct tab. 

3. Click Add Accounts. 

4. To add all accounts in the master list of accounts, select Add in All the accounts for this church. 



 

Additional Field Information 

Additional Field Information 

5. If you want to remove all accounts currently listed, select Delete Current Accounts First. 

6. Click Accept/OK. The master list of accounts is added to the listing for this church or institution. 

    

 

Go To Account 

Display the selected account's COA Detail window. 

Customize View 

Customize the grid properties and fields that display. 

Print View 

Display the Print List window where you set print properties, preview the list, and print it. 

Add Accounts 

Add the diocesan master list of accounts to the church/institution's complete COA in DioView. Accounts are not 

added to the church/institution's personal database. 
 

Parish Vendor 

The Parish Vendor tab displays information that comes from the parish's vendor table in your PDS Ledger 

program. This information displays based on the Ledger data path that you specify on the Password tab. 

The information in this grid is view-only. 

Password 

The Password tab displays the password that the church or institution uses to upload its data to your DioView 

database. For information on uploading church/institution data, see the Data Transfer tab. 

 

 

Church Password 

The password that the church or institution uses to transfer data to DioView. You can assign this password or 

retrieve it from the church or institution. 

Ledger Data Path 

Enter the location of the folder in which you store the church/institution's Ledger backup files. 

Retrieve Ledger Backup 

Retrieve and download Ledger backup files from the web service. This creates or updates a backup folder at the 

location specified in Ledger Data Path. The backup file is stored in this location after you run the synchronization 

process in DioView. 

Expand Backup 

Unzip your backup files from the web service. These files, which are uploaded to the web service after you run the 

synchronization process in the Ledger program, are loaded into the "\Data" folder at the location you specified 

in Ledger Data Path. 

Date Last Uploaded 

The date that the church or institution last transferred data to DioView. If the church/institution does not transfer 

data, this field is blank. 

Latest Closed Month 

The month that the church or institution last closed its books. If the church/institution does not transfer data, this 

field is blank. 

Church uses Realm Financials 

If your parishes use Realm Financials, you can connect their sites and pull their monthly totals into DioView. For 

more information on this feature, see Loading Data from Realm Financials. 



 

Additional Field Information 

Setting Up the Web Service Information 

To download information from churches and institutions using DioView Transfer, you must first set up your web 

service information. Go to Churches and Institutions, and on the Data Transfer tab, click Setup the Web 

Service Information. 

 

 

 

Diocesan ID 

The diocesan ID, which is the site number you entered in the License Information window when you installed your 

program. 

Set 

The suffix that PDS representatives provided you. This suffix is used to define sets of books the diocese wants to 

keep separate. 

Password 

The password that PDS representatives provided when you first set up your web service account. To view the 

password, click the field. 

Web Service URL 

The web service URL that PDS representatives provided when you first set up your web service account. An 

example web service URL is "https://secure.hostedpds.com/dioviewws.dll/bin". 

Web Service ID 

The web service ID that PDS representatives provided when you first set up your web service account. 

Web Service Password 

The web service password that PDS representatives provided when you first set up your web service account. To 

view the password, click the field. 

Test the Web Service Connection 

Verify that your web service connection is working properly. If you can't connect to the web service, contact PDS 

Support. 

Realm ID 

If your parishes use Realm Financials, you can connect their sites and pull their monthly totals into DioView. For 

more information on this feature, see Loading Data from Realm Financials. 

 

 

  



 

Additional Field Information 

Loading in the Church Data 

During this process, your program detects which churches and institutions have uploaded data since the last time 

you ran this process. Account mapping errors are also detected. Each church/institution with errors displays in red 

in the listing grid. To review a church or institution’s account mapping settings, double-click the name in the Load 

Information window. 

 

 

To download church data: 

1. On the Churches and Institutions window, click the Data Transfer tab. 

2. Click Load in the Church Data. The process detects information that churches and institutions have 

uploaded. 

3. If you're set up to pull data from Realm Financials, click Yes to refresh the data. 

4. Select the churches and institutions whose data you want to load. By default, the process selects 

churches and institutions that have uploaded data since the last time you loaded data. 

5. Click Next. 

6. The process can detect changes to closed months. To include this check in the process, select Check 

for Changes Made to Months on or Before the following date. Enter the date in MM/YYYY format. 

Otherwise, select Don’t Check for Changes Made. 

7. Click Next. 

8. To begin loading data, click Start Transfer. As your data transfers, a log of information displays in the 

Current Status box. 

9. When the transfer completes, click OK. 

10. To print the status information, click Print. 

11. To exit, click Finish. 

 

   

 

Show All Churches 

Display all churches and institutions that have uploaded data. By default, churches and institutions that have 

uploaded data since the last time you ran this process are selected. 

Show Only Those Marked as Updated of Having Errors in Their Account Mapping 

Display only the churches and institutions that have uploaded data since the last time you ran this process. This 

also displays churches and institutions that have account mapping errors. 

Don't Check for Changes Made 

Skip the process of detecting changes that churches or institutions have made to closed months. 

Check for Changes Made to Months on or Before the following date 

Detect changes that churches or institutions have made to closed months. 

 

 

  

Note 

Before you can download church data, you must set up your web service information. 



 

Useful Information 

Mapping Church Accounts to Diocesan Accounts 

Before you can load church data (whether it's from PDS or Realm Financials), church accounts must be mapped 

to your diocesan accounts. Church account codes that match diocesan account codes are mapped by the 

program automatically. All other accounts must be mapped manually. Read the following before you begin to map 

accounts. 

To Do List 

Before you map accounts: 

 Enter your master list of accounts. 

 Enter all churches and institutions on the Church/Inst. Detail tab. 

 Enter a password on the Church/Inst Detail tab for each church. 

 Set up your web service information on the Data Transfer tab. 

 Upload the diocesan setup data to the DioView server. 

 When the church or institution uploads its data, download it from the server. 

 

Useful Information 

PDS churches or institutions can also map their own accounts to diocesan accounts. They must have PDS 

Ledger or Ledger/Payroll version 5.1 or higher. 

 

When you are ready to map accounts, start by selecting default settings for the transfer of account data from the 

church/institution to the diocese. 

To set mapping process defaults: 

1. In the Churches and Institutions window, click the Church/Inst. Detail tab. 

2. To select a church or institution, click Quick Lookup. 

3. Select a church or institution from the Church Name or Church ID drop-down list and click 

Lookup/OK. 

4. Click Data Transfer Details. 

5. On the Mapping Process Defaults tab, select the defaults for this church or institutions. 

6. To import alternate account numbers from churches that have included them, click Load Alt. 

Accounts. 
 

 

Once you transfer data, alternate account numbers will display in the Comments of the Complete 

COA Detail tab for each church. 

 

7. Click Save/OK. 

    

After you set the defaults, you can map church/institution accounts that aren't already mapped to master diocesan 

accounts. 

To map church or institution accounts to diocesan accounts: 

1. In the Data Transfer Details window, click the Account Mapping tab. 

2. Under Church to Diocese Account Mapping, select the accounts you want to view. Accounts that have 

mapping errors display in red. 

3. In the grid, select an account. The account's information displays under Church Account. If a problem 

exists, it displays in the Problem field. 

4. Under Mapped to Master Account, select the diocesan master account to map the church/institution 

account to. 

 



 

Additional Field Information 

5. Repeat this for each account you want to map. If you want to reset all account mapping and start anew, 

click Reset Mapping. We recommend you make a backup before resetting account mapping. 

6. Click Save/OK. 

 

Defaults for the Mapping Process 

You can assign the default information that transfers from each church or institution. Go to Churches and 

Institutions, and click the Data Transfer Details tab. 

Your information is automatically saved when you leave this tab. 

 

 

Church/Inst. 

The ID and name of the church or institution whose defaults you're assigning. 

Start Month 

Enter the starting date of the data you want to upload from the church or institution. Any records entered before 

that date are not transferred to your records. Enter the date in MM/YYYY format. 

The Diocese Will Define the Account Mapping 

Indicate that you want to map accounts instead of having the church/institution do so. 

Prevent this Church/Inst. from Changing the Defaults 

Remove the ability for the church or institution to change any of the default selections on this tab. 

Ignore the Department Code 

Map accounts based on account codes, regardless of department codes. 

Include Current Year's Budget Totals 

Transfer the current year's budget totals for the church or institution. These totals display in the Complete COA 

Detail window on the Comparatives tab. 

Include Future Years' Budget Totals 

Transfer future years' budget totals for the church or institution. These totals display in the Complete COA Detail 

window on the Comparatives tab. 

Skip Recalculation of Retained Earnings 

When selected, the uploads from church ledgers are in balance for all cases, including those where there are 

multiple retained earnings accounts or transactions connected to retained earnings. If selected, the retained 

earnings are not recalculated for that church/institution during the Verify COA process nor synchronization. This is 

needed if the church/institution has transactions posted against the Retained Earnings account. 

Copy to All Churches/Institutions 

Copies the corresponding default(s) to all churches and institutions. 

Load Alt. Accounts 

Imports alternate account numbers from churches that have included them in Ledger/Payroll. Once you transfer 

data, alternate account numbers display in the Comments of the Complete COA Detail tab for each church. If 

there are multiple accounts mapping to one account, it pulls in the last alternate account number for that type of 

account. 

 

 

The Account Mapping Tab 

You can map individual church/institution accounts to master diocesan accounts. Go to Churches and 

Institutions, and click the Data Transfer Details tab. 



 

Additional Field Information 

  

 

 

Church/Inst. 

The ID and name of the church or institution whose accounts you are mapping. 

Show the Mapping of All of the Detail Church Accounts to Diocesan Accounts 

Display all church accounts in the grid, regardless of whether they're mapped to diocesan accounts. 

Show only Church Accounts not mapped to a Diocesan Account 

Display only the accounts that haven't already been mapped to diocesan master accounts. 

Print Mapping 

Print a listing of all church/institution accounts and the diocesan accounts they're mapped to. 

Reset Mapping 

Reset all mapped accounts. We recommend you create a backup before resetting mapped accounts. 

Church Account 

The selected account number, name, type, and problems, if any. 

Mapped to Master Account 

Select the diocesan master account you want to map the selected church/institution account to. 

 

 

Updating the Diocesan Setup Data 

The Update the Diocesan Setup Data process automatically transfers DioView data to our secure web service. 

When churches and institutions attempt to transfer their data to DioView, their web service information and 

passwords must match the data on this server. 

The data included on the server also includes your diocesan master list of accounts, which churches and 

institutions compare to their chart of accounts (COA). This automated process notifies the church or institution of 

any errors in their COA before they upload. 

 

To update the diocesan setup data: 

1. On the Churches and Institutions window, click the Data Transfer tab. 

2. Click Update the Diocesan Setup Data. 

3. Click Start Transfer. As your data transfers, a log displays in the Current Status box. 

4. When the transfer completes, click Print to print the status information. 

5. Click Finish to exit the process. 

 

Loading Data from Realm Financials 

DioView can load parish ledger information from Realm Financials. Unlike in other data transfers, parishes don't 

need to 'push' the data to your diocese. Instead, parishes can authorize the diocese to pull the account totals from 

Realm. 

 

Note 

Before you can update diocesan data, you must set up your web service information. 

Useful Information 

Only account totals are pulled in. No details on transactions or vendors are transferred. 



 

Here are the steps to load parish data from Realm: 

 Set up your web service information. 

 Add the Realm Site ID to each parish record. 

 Have parishes authorize the data transfer. 

 Link to Realm and define account mapping. 

 Load the Realm data. 

Set Up Web Service Information 

Your diocese will be assigned a Realm ID for using this process. Email our Diocesan Support team to get your ID. 

Once you have your Realm ID, enter it in your web service information. 

To set up your Realm ID: 

1. On the Churches and Institutions window, click the Data Transfer tab. 

2. Click Set up the Web Service Information. 

3. Enter the Realm ID you were given by the Diocesan Support team. 

 

4. Enter any other information, if needed. 

5. Click Save then Close. 

Add Realm Site IDs 

For each parish that uses Realm Financials, you must add the Realm Site ID to the DioView record. This will be 

used to link the Realm account once the parishes authorize the connection. 

To add parish site IDs: 

1. In the Churches and Institutions window, click Church/Inst. Detail. 

2. Locate the parish that uses Realm. 

3. Click the Password tab. 

4. Select Church uses Realm Financials. 

5. Enter the Realm Site ID for this parish. 
 

Useful Information 

Parishes can locate their site number in Realm by going to Admin > Manage Realm 

Account > Account Summary. The 6-digit ID displays in the green box at the top-right. 
 

6. Click Save. 

Get Parishes to Authorize the Connection 

Each parish must allow your diocese to pull their monthly account totals within Realm. Contact your parishes to 

authorize the connection in Realm. For steps, they can click the Realm help icon and search for the topic "Set up 

Realm Accounting". 



 

Link to Realm and Define Parish Mapping 

Once the connection is authorized with each parish, you can load the Realm data. You'll see the list of accounts 

at each parish. In most cases, this list won't match the diocese's accounts, so you need to define a mapping. All 

accounts must be mapped before you can pull in monthly totals. 

To map parish accounts: 

1. In the Churches and Institutions window, click Church/Inst. Detail. 

2. Locate the parish that uses Realm. 

3. Click the Password tab. 

4. Click Attach to Realm. 

 If mapping differences are found, you're prompted to open the Data Transfer Details. Click Yes to 

fix any problems with mapping. For help, see Mapping Church Accounts to Diocesan Accounts. 

 

 

 

 

 

 

 

 Otherwise, if no mapping differences are found, click OK to confirm that parish accounts have 

been mapped. 

 

 

 

 
5. Repeat this for each parish. 

Load Realm Data 

Once you mapped all accounts, you can load the Realm data. 

To load parish data from Realm: 

1. On the Churches and Institutions window, click the Data Transfer tab. 

2. Click Load in the Church Data. 

3. Click Yes to refresh the data from Realm churches. 

 

4. Select the parishes you want to load data for. 

5. Click Next. 

6. The process can detect changes to closed months. To include this check in the process, select the 

option and enter the date in MM/YYYY format. Otherwise, select Don’t Check for Changes Made. 

7. Click Next. 

8. To begin loading data, click Start Transfer. As your data transfers, a log of information displays in the 

Current Status box. 

9. When the transfer completes, click OK. 

10. To print the status information, click Print. 

11. To exit, click Finish.  

Useful Information 

If there are any mapping errors that were not fixed earlier, they'll display in red text. 



 

Useful Information 

Additional Field Information 

Master List of Accounts 

The master list of accounts is your diocesan chart of accounts (COA). You can edit, view, and print reports on the 

account sums for all your churches and institutions. You can access Master List of Accounts from the main menu 

or the File menu. 

Master Account Detail 

The Master Account Detail tab displays all the information about each account. You can add new accounts in this 

window. Go to Master List of Accounts, and click the Master Account Detail tab. 

To add an account: 

1. Click Add Account. 

2. In the Account Number field, enter the master account number for the church and institutional accounts 

you want to sum together. 

3. For a range of accounts, enter the last account number of the range in the Thru field. 

4. In the Account Name field, enter the name for this account. 

5. In the Account Type field, enter the name of the account type or click the ellipsis icon (...) to select a 

type. 

6. Enter values in the fields, and select any check boxes that apply to this account. For more on these, see 

the Additional Field Information. 

7. In the Comments field, enter optional notes about the account. 

8. When you finish, click Save. 

9. To make sure your accounts are totaled and ordered correctly, click Verify COA. 

 

 

You must verify your COA each time you change an account number, name, level, or type. We 

recommend that you also do this when you alter a beginning balance or mark an account as a master 

or sub. 

   

After adding a new account, make sure you map church accounts accordingly and update diocesan setup data. 

 

 

 

Account Number 

Displays the identification number for the account. 

Thru 

Displays the last account number in a range of accounts. You can use this field to incorporate church or 

institutional variations of your master diocesan account. 

For example, you want to view a total of all petty cash accounts for all churches and institutions. You want to 

assign a range of 1000 to 1100 to incorporate all petty cash accounts, so you enter "1000" in the Account Number 

field and "1100" in the Thru field. As a result, a church or institution can assign multiple petty cash accounts in 

that range — 1005 for clergy petty cash, 1010 for special lunch, and so on. When you view the account detail for 

petty cash, you see a sum of all church and institution accounts that fall in this range. 

Inactive 

Removes the account listing from reports and new transactions. Existing transactions remain active. 

Account Name 

The account name as it displays on transactions and reports. You can use one name for multiple accounts. 

Account Type 

Enter the account type in this field or click the ellipsis icon (...) to select a type. 



 

Account Description  

The account category, report type, and normal balance. The report type can be a balance sheet or an income 

statement. The normal balance can be debit or credit. 

Total Level  

Enter the total level you want to attribute to the account. The total level determines which accounts to add 

together. This field does not display for heading accounts. 

Level one is the lowest level and is for detail accounts. Major subtotals like total assets, total liabilities or equity, 

total income, and total expenses have the same level, usually level eight. Reserve level nine, the highest, for your 

net profit or loss account. Use other levels to create various subtotals. 

Balance Sheet Column  

Enter the number of columns to display on balance sheets. You can print columns 1 through 3 on the balance 

sheet. This field displays for balance sheet accounts, but not for heading accounts. 

Blank Lines After  

Enter the number of blank lines to print after the accounts on reports. Heading accounts are automatically 

followed by a blank line, and total accounts are automatically preceded by a blank line. 

Master Account  

Hide detail in reports. This option displays for detail accounts. A master account includes the sum of all its sub 

accounts. You cannot post transactions to a master account. You can enable master and sub accounts in the 

Initial Setup window. 

Sub Account  

Hide detail in reports. This option displays for detail accounts. If you post transactions to a subaccount, you can't 

change it to a master account. You can enable master and sub accounts in the Initial Setup window. 

New Page After  

Add a page break after the selected account entry on a report. All data that displays after the information for the 

selected account prints on following pages. 

Comments  

Enter any notes about the selected account. 

Prior Year Fund Balance Account  

This field displays for retained earnings accounts if you've allowed multiple retained earnings and prior year fund 

balances in the Initial Setup window. This is a special type of equity account that represents the accumulated 

retained earnings from previous years. At the end of each fiscal year, the retained earnings balance is added to 

the prior year fund balance account. Each Chart of Accounts must have a prior year fund balance. 

Retained Earnings Account  

This field displays for income and expense accounts if you've allowed multiple retained earnings and prior year 

fund balances in the Initial Setup window. This is a special type of equity account that's equal to the net profit or 

loss account. Each Chart of Accounts must have one item for retained earnings. 

 

View Listing 

The View Listing tab displays a list of groups. You can only view the information in this window. Go to Master List 

of Accounts, and click the View Listing tab. 

 

 



 

Additional Field Information 

Additional Field Information 

 

 

Active 

Displays accounts marked as active in the master list of accounts. 

Inactive Only 

Displays accounts marked as inactive in the master list of accounts. Inactive accounts display in red. 

Both Active and Inactive 

Displays all accounts. Inactive accounts display in red. 

Order by 

Select a sort order for accounts. To navigate through the account list, use the navigation arrow buttons. 

Customize View 

Customize the grid properties and the fields that display. 

Print List 

Print all active items in the list. 

Zoom 

View a full-screen display of the listing grid. To return to normal size, click Zoom again. 

 

Master Account Reports 

The Master Account Reports tab displays a list of group reports available to print. Go to Master List of 

Accounts, and click the Master Account Reports tab. To display the list of reports, click the arrow beside the 

report heading. You can access all reports on the main menu. 

 

 

Add 

Add a report to the easy report list for the selected heading. You can select the type of report that you want to 

create. 

Delete 

Remove the selected report that you added or copied. You cannot remove predefined reports. 

Copy 

Copy the selected report so that you can modify the original report without overwriting it. 

Reorder User Reports 

Customize the order in which the report list displays. 

Adv. Script 

Edit the programming for reports that you added or copied. This is an advanced process. 

Save as Custom Report 

Save the report you added or copied. 

View Sample 

Display a one-page sample of the selected report using sample data. 

 

  



 

Additional Field Information 

Additional Field Information 

Complete COA 

The chart of accounts (COA) is the backbone of your accounting system. It includes assets, liabilities, equity, 

income, and expenses. You can get to the Complete COA from the main menu or the File menu. 

Complete COA Detail 

The Complete COA Detail tab displays information about each account. You can add new accounts in this tab. Go 

to Complete COA, and click the Complete COA Detail tab. For information about the subtabs in this window, 

see Complete COA Detail Subtabs. 

If a church or institution does not have PDS Ledger or PDS Ledger/Payroll, you can manually add the accounts 

into your database. All accounts must be in the Master List of Accounts before you can assign them to a church or 

institution. 

To assign an account to a church or institution: 

1. In the Complete COA Detail window, click Add Account. 

2. Select the church ID or name from the corresponding drop-down list. 

3. Select the account number or name from the corresponding drop-down list. 

4. Click Add/OK. 

   

 

 

Church ID/Name 

The identification number and name of the church. 

Account Number 

The identification number for the account you're viewing. You can view the same account for different churches by 

using the Quick Lookup tool. For more about account numbers, see Formatting Account Numbers. 

Account Name 

Identifies the account for transactions and reports. You can use one name for multiple accounts. 

Inactive 

Remove the account listing from reports and new transactions. Existing transactions remain active. 

Date Changed 

The date that you last edited the account information. 

 

View Listing 

The View Listing tab displays a list of account information. You can customize the columns that display. Go to 

Complete COA, and click the View Listing tab. By default, this tab displays the account number, account name, 

category, report type, account type, and normal balance. 

The information in this window is for viewing purposes only. 

 

 

Active Only 

Displays accounts marked as active in the COA. 

Inactive Only 

Displays accounts marked as inactive in the COA. Inactive accounts display in red. 

Both Active and Inactive 

Displays all accounts. Inactive accounts display in red. 



 

Additional Field Information 

Order by 

Lists accounts in the selected order. To select another sort order, click this button. 

Customize View 

Customize the grid properties and the fields that display. 

Print List 

Prints all active items in the list. 

Zoom 

View a full-screen display of the listing grid. To return to normal size, click Zoom again. 

 

COA Report 

The COA Reports tab displays a list of reports available to print for the COA. Go to Complete COA, and click the 

COA Reports tab. 

To display the list of reports, click the arrow beside the report heading. You can see all reports on the main menu. 

 

 

Add 

Adds a report to the easy report list for the selected heading. Select the type of report that you want to create. 

Delete 

Removes a report that you added or copied. You can't remove predefined reports. 

Copy 

Copies the selected report so that you can modify the original report without overwriting it. 

Reorder User Reports 

Customize the order of the reports you added or copied. 

Adv. Script 

Edit the programming for reports that you added or copied. This is an advanced process. 

Save as Custom Report 

Saves the report you added or copied. 

View Sample 

Displays a one-page sample of the selected report using sample data. 

 

  

 

Complete COA Detail Subtabs 

These tabs display on the Complete COA Detail tab in the Complete COA window. 

General Information 

The General Information tab displays the basic information about each account. Go to Complete COA, and click 

the Complete COA Detail tab. 

 

 

 



 

Additional Field Information  

Account Type 

Identifies the type of account. 

Account Description 

The account category, report type, and normal balance. The report type can be a balance sheet or an income 

statement. The normal balance can be debit or credit. 

Total Level 

Identifies accounts that the diocese wants added together. You can't edit this field. This field does not display for 

heading accounts. 

Balance Sheet Column 

Displays for balance sheet accounts. You can print columns 1 through 3 on the balance sheet. This field does not 

display for heading accounts. 

Blank Lines After 

Indicates the number of blank lines to print after the account on reports. Heading accounts are automatically 

followed by a blank line, and total accounts are automatically preceded by a blank line. 

Beginning Balance 

Displays only for balance sheet detail accounts. Displays the first balance you enter for an asset, liability, or equity 

account. If you use a journal entry to transfer money to this account, you can enter "0". 

Altering the beginning balance changes information on reports, such as balance sheet and income statement, 

even for closed periods. If you need to change the beginning balance, reprint all reports since the beginning of the 

fiscal year. 

Master Account 

Hide detail in reports. This option displays for detail accounts. A master account includes the sum of all its sub 

accounts. You cannot post transactions to a master account. You can enable master and sub accounts in the 

Initial Setup window. 

Sub Account 

Hide detail in reports. This option displays for detail accounts. If you post transactions to a subaccount, you can't 

change it to a master account. You can enable master and sub accounts in the Initial Setup window. 

New Page After 

Add a page break after the account entry on a report. All data that displays after the information for the selected 

account prints on following pages. 

Comments 

Displays notes about the account. A list of parish accounts that map into the selected account automatically 

display in this section. If you imported alternate account numbers from churches that have included them in 

Ledger/Payroll, they display in this section. And, if there are multiple accounts mapping to one account, it pulls in 

the last alternate account number for that type of account. 

Prior Year Fund Balance Account 

This field displays for retained earnings accounts if you've allowed multiple retained earnings and prior year fund 

balances in the Initial Setup window. This is a special type of equity account that represents the accumulated 

retained earnings from previous years. At the end of each fiscal year, the retained earnings balance is added to 

the prior year fund balance account. Each Chart of Accounts must have a prior year fund balance. 

Retained Earnings Account 

This field displays for income and expense accounts if you've allowed multiple retained earnings and prior year 

fund balances in the Initial Setup window. This is a special type of equity account that's equal to the net profit or 

loss account. Each Chart of Accounts must have one item for retained earnings. 

 

 



 

Additional Field Information 

Actuals 

The Actuals tab displays up to 8 years of information for each account, including the next year, the current fiscal 

year, and six previous years. Go to Complete COA, and click the Complete COA Detail tab. This window does 

not display for heading accounts. 

You can edit actuals totals for any year except the current fiscal year. As you process transactions, the actual 

balance of balance sheet accounts is updated. The monthly, quarterly, and yearly totals of income statement 

accounts are also updated. 

The tab displays your accounting approach: cash basis or accrual basis. You can change your accounting 

approach in the Initial Setup window. 
 

 

 

Cash Basis Accounting 

Income is recorded in the period that cash is received. Expenses are recorded in the period that cash is paid. This 

method is generally easier to understand, set up, and maintain. All of the accounts that you need have already 

been set up as part of your normal chart of accounts — cash, income, and expense. 

Accrual Basis Accounting 

Income is recorded in the period in which it is earned. Expenses are recorded in the period in which they are 

incurred. You must have at least one receivables account (an asset) for uncollected receivables. You also must 

have one payables account (a liability) for unpaid invoices. You can have additional accounts for different types of 

income or expenses. 

 

Budget 

On the Budget tab, you can maintain up to 8 years of budget information for all of your income and expense 

accounts. You can enter budget information for 5 future years, the current year, and 2 previous years. Go to 

Complete COA, and click the Complete COA Detail tab. 

Yearly totals are evenly dispersed among months and quarters. If you enter or edit a quarterly total, the figure is 

evenly dispersed among the months in that quarter. The yearly total also updates. If you edit a monthly total, your 

quarterly and yearly totals update. You can't enter budgets for heading, total, asset, or liability accounts. 

You can hide the Budget tab with the option on the Initial Setup window. If you hide budgets, your budget figures 

are still maintained. 

Comparatives 

On the Comparatives tab, you can compare actuals or budget totals for any income or expense account. Go to 

Complete COA, and click the Complete COA Detail tab. 

Assets and liabilities display only actuals totals for comparison. To compare budget totals, you must activate 

budgets. For more information, see the Budget tab on this page. 

Select the years you want to compare from the drop-down lists. Asterisks indicate that the selection is the current 

fiscal year. To view monthly totals, select Monthly. To view cumulative totals up to the current period, select YTD. 

View Parish Transactions 

The View Parish Transactions tab displays the transactions from parishes that affect your account. These parish 

accounts are also listed in the Comments section of the General Information tab. 

Click Ledger Details to open the PDS Ledger program and view current Ledger details. Before using this feature, 

enter the Ledger data path on the Password tab in the Church/Inst Detail Subtabs. 

  



 

Processes 

At the end of the fiscal year, you can run your financial reports and close all monthly and yearly transactions. 

 

Close Fiscal Year 

The Close Fiscal Year process closes the year's transactions. Before you run this process, print all yearend 

financial reports. The process does not delete transactions. You cannot edit transactions once you close the fiscal 

year. If you need to make a correction, you must reverse the transactions in the new period. 

The process does the following: 

 Verifies the current month is the last month of this fiscal year. If this is true, the process closes it. Posts 

the net profit or loss total to the retained earnings account for each set of books. It then adds the retained 

earnings to the prior year fund balance account. Finally, it sets the beginning balance of the retained 

earnings account to zero. 

 Updates the Actuals and Budget tabs in the Complete COA Detail window. Information from the oldest 

year on these tabs is deleted. 

 Sets the actuals total to zero for income and expense accounts. For assets and liabilities, the first month 

of the new fiscal year will have the ending balance from the prior year as the total. 

 Adds the prior year's ending balance to the first month of the new fiscal year in assets and liabilities 

accounts. 

 Advances the fiscal year in the Initial Setup window. 

 

Useful Information 

Back up your data before you close the fiscal year. 

 

To close the fiscal year, click Processes on the main menu, then click Close Fiscal Year. 

After you complete this process, you can enter transactions for the new fiscal year.  

  

Note 

Make sure you run your reports before you close a period.  



 

Additional Field Information 

COA Groups 

The COA Groups window includes group lists of account numbers. With group lists, you can rearrange the chart 

of accounts, details, levels, headings, and totals to create specialized reports. You can access COA Groups from 

the main menu or the File menu. 

Group Detail 

You can create and customize group lists. Go to COA Groups, and click the Group Detail tab. 

To add a group: 

1. Click Add Group. 

2. Enter a group name and description. 

3. To select accounts for the group, click Add Accounts. 

4. Select the accounts that you want to include in the group. 

5. Click Save/OK. 

6. Select a source for each account. 

7. Click Save. 

   

 

 

Group Name 

Displays the name of your group list. You run reports for a specific group. Each group name must be unique. 

Description 

Displays the group list description. 

Move Up and Move Down 

Moves the selected account higher or lower in the list. 

Show List / Show Detail 

Displays or hides the detailed information. 

Insert Entry 

Inserts a new entry above the selected line in the list of accounts. You can then provide details for the new entry. 

Add to the End 

Inserts a new entry at the end of the list of accounts. You can then provide the details for the new entry. 

Add Accounts 

Select the accounts to add to the group. By default, the program sets the source as Print account. 

Delete Entry 

Removes an account from the list. 

Remove All 

Removes all accounts from the list. 

Source 

Includes options for setting the information that displays in a report. You can select a source for each account in 

the list. If you enter an alternate number, it displays instead of the account number on reports. 

 Print account — Displays the actuals balance, name, type, and level for the selected account. Use this 

for heading or detail accounts. 

 Include account but hide the detail — Calculates actuals totals for the selected account number. The 

account does not display. Use this for hiding details and total accounts in calculations. 

 Include account but hide the detail with alterations — Calculates actuals totals for the selected 

account. The account does not display on reports. You can edit the group list properties for the account 

without changing your COA properties. Edited items display in blue. Use this source for hiding detail and 

total accounts in calculations. 



 

 Print total of the hidden detail — Calculates the total for accounts with the Include account but hides 

detail source. The account name prints on reports. Make sure the total level is at least one number higher 

than the level of the hidden accounts. 

 Print total of the hidden detail with alterations — Calculates the total for accounts with the Include 

account but hides detail source. The account name prints on reports. You can edit the group list 

properties for the account without changing your COA properties. Edited items display in blue. 

 Print amount from total account — Calculates and prints the actuals balance from the selected total 

account. This balance matches the amount on the Actuals tab in your Complete COA Detail window. 

 Print a new heading account — Displays the account name as a new heading. 

 Print a new detail account — Displays the account name as a new detail account. You can use this 

source to modify your current master and sub relationships. For information on enabling master and sub 

accounts, see Setting Initial Program Options. 

 Print a new total account — Calculates the total of the accounts listed above this line based on the total 

level. The new account name or account number displays on reports. Make sure the total level is at least 

one number higher than the level of the hidden accounts. Set the balance sheet column to indicate where 

the total prints. 

 Print a new net account — Adds income and subtracts listed expense amounts for a new net income 

total. The account name and account number display on reports. For net income accounts, enter your 

highest total level. 

 Print blank line — Prints a blank line to provide additional spacing in your report. 

 Print a sum of the net accounts — Creates a total of the previous Print a new net account sources and 

any Print account sources for your actual net income account. You do not need to assign a level. This 

entry is equal to any net account line above it. 

 Add in and print the account — Combines accounts from different categories into one group list. The 

added accounts display on reports. 

 Add in the account but hide the detail — Combines accounts from different categories into one group 

list. The added accounts do not display on reports. 

 Subtract out and print the account — Subtracts an account from another account. Accounts can be 

from different categories. The subtracted accounts – subtrahends – must follow the account from which 

they are subtracted – minuend – in the group list. The subtrahends display on reports. 

 Subtract out the account but hide detail — Subtracts an account from another account. This source is 

similar to Subtract out and print the account, but the subtrahends do not display on reports. 

 Print account with alterations — You can edit the group list properties for the account without changing 

your COA properties. You can make the same alterations as the Include account but hide the detail 

with alterations source. Edited items display in blue. 

 Print a set of accounts — Combines each account into a set. This source prints just as the Print 

Account source. For more information, see Using Sets of Accounts. 

 Include a set of accounts but hide detail — Includes a set of accounts but does not display them on 

reports. This source prints just as the Include account but hide the detail source. For more information, 

see Using Sets of Accounts. 

 Print a set of accounts as a single entry — Includes a set of accounts and prints a single line with the 

total. For more information, see Using Sets of Accounts. 

 Subtract out a set of accounts — Uses a pattern to define a set of accounts. It acts as a wild card to 

determine the total amount to subtract. For more information, see Using Sets of Accounts. 

 Subtract out a set but hide the detail — Includes the same options as Subtract out a set of 

accounts but does not print the account on reports. 

 Add in beg. bal. of account but hide detail — Adds only the beginning balance to reports. The account 

does not display. 

 Subtract out beg. bal. of account but hide detail — Subtracts the beginning balance amount but does 

not print the account on the report. 

 

Order by 

Sorts group lists in the selected order. To navigate through group lists, use the navigation arrows. 

Add Group 

Creates a new group list. See the procedure above for steps on adding a group. 



 

Additional Field Information 

Additional Field Information 

Quick Lookup 

Select a group list to display. 

Delete Group 

Deletes the selected group list. 

Copy Group 

Copies the selected group list. You can then change the copied group name. 

Load from a File 

Opens a saved group list file. 

Save to a File 

Saves a file of the group list. 

View Listing 

The View Listing tab displays a list of groups. You can customize the columns that display, but you cannot edit 

information in this window. Go to COA Groups, and click the View Listing tab. 

 

 

Order by 

Lists accounts in the selected order. To select another sort order, click this button. To navigate through the list, 

use the navigation arrows. 

Customize View 

Customize the grid properties and the fields that display. 

Print List 

Prints all active items in the list. 

Zoom 

View a full-screen display of the listing grid. To return to normal size, click Zoom again. 

Reports 

The Reports tab displays a list of group reports available to print. Go to COA Groups, and click the Reports tab. 

To display the reports, click the arrow beside the report heading. You can access all reports from the main menu. 

 

 

Add 

Adds a report to the easy report list for the selected heading. Select the type of report that you want to create. 

Delete 

Removes a report that you added or copied. You cannot remove predefined reports. 

Copy 

Copies the selected report so you can modify the original report without overwriting it. 

Reorder User Reports 

Customize the order that the report list displays. 

Adv. Script 

Edit the programming script for reports that you added or copied. This is an advanced process. 

Save as Custom Report 

Saves the report you added or copied. 

View Sample 

Displays a one-page sample of the selected report using sample data. 



 

Using Sets of Accounts 

A set of accounts is based on a series of common digits (like a pattern) in the account numbers. For example, 

30XX includes accounts 3000 – 3099. XX20 includes any accounts that end in 20. Printing accounts in sets can 

save time and space. 

To set a range of account numbers, use brackets in the pattern. To separate values in the range, use colons. To 

separate individual parts in the pattern, use commas. 

  

See the examples below. Colors added to show the patterns. 

To set a range for accounts 3000 – 3020, enter:  30[00:20] 

To set a range for accounts 3021 – 3099 and 3521 – 3599, enter:  [30,35] [21:99] 

  



 

Reports 

Reports gather data from your program and output information in a meaningful way. There are some predefined 

reports available to print, or you can create your own. 

 

Printing Reports 

The program has some predefined reports available for you to select, customize, and print. 

Selecting a Report 

There are a few ways to locate reports. 

Select from All Reports 

In the Reports window, click the triangle next to each group to expand and view reports. Click a report to view the 

description and a sample. 

Select from a Specific Group 

In any major data window (such as Churches and Institutions), click the Reports tab at the top. 

Print Directly from a Window 

Open internal reports by clicking Print in one of the following program areas: 

 Any keyword list 

 Calculator (Print option on the Tape menu) 

 Any Listing window (Print List button) 

 Users/Passwords window (Print Worksheet button) 

 View Log of User Activity (Log Report button) 

Printing a Report 

After selecting or creating a report, you can print it. Use the default layout options or make changes before 

printing. 

To print a report: 

1. After selecting the report you want, click Next. 

2. If needed, you can edit the report description and/or select the printer settings. Click Next. 

3. The Layout window displays. Depending on the type of report, you can edit certain elements, such as 

the fields to print, how addresses should be handled, and so on. Make any selections you want, and 

click Next. 

4. Select which records to include in the report. Use Additional Selections to filter further. 

5. To view the report before printing, click Preview. 

6. To make changes to layout or selections, click Back. 

7. When you're happy with how the report looks, click Print. 

 

Selecting Records to Print 

You can select which records to include in your report. In the Reports wizard, the Selection window displays 

different tabs that relate to the report you selected. On each tab, you can select a group of records based on 

certain conditions. 

 

 



 

Additional Field Information 

Selection Info 

You can sort your data and include active/inactive records in your report. 

 

   

Sortation 

You can determine the order of the printed report data. The available options change depending on the type of 

report you select. 

Contact Information (if printed) 

If contact information prints on the report, select this option to include the primary contacts or the selected 

contacts from the Contact Selections tab. You can also skip parishes that don't have these selected contacts 

listed in the record. 

Church Latest Download Information 

Include all parishes or only those that have posted data since a specific date. 

Date Range 

Available for the Statement of Activities and Excel Export reports. Enter a date range for the report. 

Report Date 

Available for the Statement of Financial Position report. Enter the month the report is run. 

 

Church/Inst. 

Select which churches or institutions to include in your report. 

To insert churches or institutions: 

1. Select one of the following options: 

 Include ALL active churches/institutions 

 Include active churches/inst. with a size between <number> and <number> (inclusive) 

 Include ANY of the following churches/Institutions 

2. If you selected Include active churches/inst. with a size between <number> and <number> 

(inclusive), enter values in the available fields. 

3. If you selected Include ANY of the following churches/Institutions, select the check box beside 

each item you want to include. Click a letter of the alphabet to display churches or institutions that start 

with that letter. 

4. To clear the selections you made, click Clear All. 

5. To find a church or institution quickly, click Quick Lookup. 

6. To view the report with the selections you have made, click Preview. 

7. If you plan to use this report criteria in the future, click the Selection Information tab, then Save. 

Contact 

Select contacts to include in your report. This is available if you selected Selected Contacts for Contact 

Information (if printed) on the Selection Information tab. 

To select a contact: 

1. Select one of the following options: 

 Include ALL active contacts 

 Include contacts that have a position of <position> 

 Include ANY of the following contacts 

2. If you selected Include contacts that have a position of <position>, select the position you want 

from the drop-down list. 



 

Useful Information 

The Master and Sub check boxes only display if master/sub accounting is selected in Initial Setup  

on the System Processes menu. 

3. If you selected Include ANY of the following contacts, select the check box beside each contact’s 

name you want to include. 

4. To clear the selections you made, click Clear All. 

5. To view the report with the selections you have made, click Preview. 

Chart of Accounts 

This tab displays for Chart of Accounts reports, including Statement of Financial Position, Original Balances, 

Monthly Actuals, and Church Comparison Statistical Report. Select the account category account type and 

master/sub relation. Only accounts that match those check boxes print on your report. 

 

 

 

 

To select an account: 

1. Select one of the following options: 

 Include ALL active and inactive accounts 

 Include ONLY active accounts 

 Include accounts that have the following Account Numbers 

 Include the following Church ID/Account Numbers 

2. If you selected Include accounts that have the following Account Numbers, then select the account 

numbers you want to include. 

3. If you selected Include the following Church ID/Account Numbers, select the check box beside 

each item you want to include. 

4. Click Mark All to select all of the available check boxes. Click Clear All to clear the marks from all of 

the check boxes. 

5. To view the report with the selections you have made, click Preview. 

Additional Selections 

Use the Additional Selections tab to create a specific set of criteria for a report. The fields and values available 

depend on the type of report you selected. You can filter your list of report criteria to a very specific level, for 

example: 

 Churches/Institutions in Phoenix, AZ 

 Churches/Institutions with more than 1,500 members 

 Churches/Institutions within the 29544 area code 

Practice using the Additional Selections tab to learn more about how to use it efficiently. Right-click field names to 

see a description. 

 

Information about conditional relations: 

 

 Is equal to — Field = Value. Example: Church City is equal to Phoenix. 

 Is not equal to — Field ≠ Value. Example: Church City State is not equal to Phoenix, Arizona. This 

relationship is useful when you want everything other than a specific value. 

 Is less than — Field < Value. Example: Church ID is less than 3000. 

 Is less than or equal to — Field ≤ Value. Example: Church ID is less than or equal to 3000. 

 Greater than — Field > Value. Example: Church ID is greater than 3000. 

Useful Information 

Some relationships are not available for certain fields. 



 

Additional Field Information 

 Greater than or equal to — Field ≥ Value. Example: Church ID is greater than or equal to 3000. 

 Is in list — The field is within a list of values. Each value must be in quotation marks and separated by 

commas. Example: Church City State is in list "Phoenix", "Glendale". 

 Is not in this list — The field is not within a list of values. Each value must be in quotation marks and 

separated by commas. Example: Church Mailing City/State is not in this list "Phoenix", "Glendale". 

 Starts with — The field has the same beginning character or characters as the value in question. 

Example: Church Name starts with A. 

 Does not start with — The field has a different beginning character or characters than the value in 

question. Example Church Zip does not start with 85. 

 Contains — The field includes the value. Example: Church E-Mail contains "gmail". This returns a list of 

all family email addresses include the word "gmail" in it. 

 Is not between — The field falls outside of two values. Example: Church ID is not between 300 and 800. 

 Is between — The field falls between two values. Example: Church ID is between 300 and 800. 

 Is ever equal to — The value in the field is equal to at least one of the fields entered. Example: Church 

ID is ever equal to 100. 

 Is never equal to — The value in the field is not equal to one at least one of multiple fields entered. 

Church ID is never equal to 100. 

 

Information about the numbered button menu items: 

As you add conditions on the Additional Selections tab, a numbered button displays beside the statement. When 

you click the numbered oval , the following options are available: 

 Add Condition — Adds a new field, relation, and value for your condition line. 

 Add Sub-section — Adds a new set of criteria to be considered as a group. Condition statements within 

the subsection are evaluated, in order, before condition statements outside of the subsection. 

 Enable/Disable Row — Condition lines can be turned on and off without being deleted. This way, you 

can test conditions and combinations more quickly. Any disabled rows are considered when the report is 

run. Disabled rows are gray. 

   

 

Clear Additional Selections 

Removes all condition lines. 

Exclude rather than include selected records 

When selected, the main condition phrase at the top of this window changes from Choose records... to Exclude 

records.... All items that match the given conditions are excluded, and the rest are printed. 

 

Creating Reports 

The program has many predefined reports to select from. However, if you can't find one that suits your needs, you 

can create a new report. These are called Easy Reports. 

Copying Existing Reports 

Before adding a new report, make sure there isn't an existing report you can modify. It's much easier to modify a 

report than it is to create a new one. 

To copy a report: 

1. In the reports list, select the report you want to copy and modify. 

2. Click Copy. The report is added to the Easy Reports section of the same report group. 

3. Select the copied report, and click Next. 

4. Follow the Reports wizard to define and customize your report. 



 

Tip 

Before adding a report, we recommend that you outline the information you want to include and  

make notes about formatting. This gives you something to work from. 

Adding New Reports 

If you can't locate a report similar to what you need, you can add a new one. 

 

 

 

 

To add an Easy Report: 

1. In the reports list, select the group where you want to add your report. 

2. Click Add. Click the type of report you want to create. The new report is added to the Easy Reports 

section within the report group you selected. 

3. Select the added report, and click Next. 

4. Edit the report name and description, then follow the Reports wizard to customize your report. 

 

New Easy Reports are automatically added at the end of the Easy Reports section. You can reorder them and 

create subgroups to further organize your reports. 

To organize Easy Reports: 

1. In the report list, expand the Easy Reports group heading. 

2. Click Reorder User Reports. 

3. Click the report you want to relocate, then click the up or down button to move it in the list. 

4. To create a new section, click Add a Section Name, and enter a name. 

5. Click Save/OK. 

 

Listing Reports 

Listing reports describe a broad category of reports that not only includes lists of items, but church information, 

statistical reports, and information about closed books and uploads. Listing reports give you the ability to select 

and modify the page style and margin style. You can find Listing reports under Church /Inst. Reports, Chart of 

Account Reports, Master List of Accounts, and Group Reports family, financial, member, and member certificate 

reports. 

Location Listing Reports 

On the main menu, click Reports. Under the Church/Inst. Reports, Chart of Accounts, and Master List of 

Accounts report groups, double-click Listing Reports to expand the available reports. Select a listing report to 

print. 

Listing Layout Window 

When you select a Listing report, the Report Wizard displays the Set Name and Description window. To view the 

Set the Listing Layout window, click Next. Use the options in this window to change the page style and margin 

style. Additionally, select which fields print, or modify the way fields, such as addresses and phone numbers, 

print. To view a sample of your report, click View Sample. 

 

Page Style 

The page style sets the layout and fonts for reports. To select an option, click the Page Style drop-down list. You 

can add new page styles or modify/delete existing ones. If an existing style is changed, it's changed for all reports 

using it. Each descriptive page style name must be unique. 

 



 

Useful Information 

Use a margin setting of 0.000 to begin printing at the smallest margin for the printer selected. 

To insert or edit a page style: 

1. In the Listing Layout window, under Page Style, click Edit Style. The Edit Style dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select a page style name. 

3. On the General Information tab, enter a unique style name if you are setting up a new page style. The 

*Normal Format is installed with the program and is the most commonly used style. Click the drop-down 

list to select the page number, position, today’s date, and note position. 

4. To change the fonts used in the report, on the Font tab, click Set Font to select the font you want to 

use for Title Font, Heading Font, Detail Font, or Date/Page Font. 

5. You can add horizontal and vertical lines as well as double spacing and shading. On the Lines and 

Shading tab, select the options you want to use: 

 Horizontal Lines — Prints a line after each family, member, or fund. 

 Vertical Lines — Prints a line on the left and right side and separates each column. 

 Double Space — Inserts an extra line between each family, member, or fund. 

 Gray Heading — Shades the headings area. 

 Gray Alt. Bands — Alternates light gray and white rows. 

6. To save your new page style, click Save/OK, then Close. 

 

Fields to Print 

The Modify the List of Fields to Print button is unavailable unless a new Listing report is added or copied. 

To select fields to print on a new or copied listing report: 

1. In the Set the Listing Layout window, click Modify the List of Fields to Print. 

2. Under Fields Available to Print, double-click the field names to move them under Fields You Want To 

Print. Or, select the field name and click the right arrow (>) to move them. To remove a field name, 

select the name and click the left arrow (<) to return it to Fields Available to Print. 

3. To rearrange the field names under Fields You Want to Print, select a field name and click the up and 

down arrows to change the order of the columns. 

4. To set the print location of each field name, select each field name in Fields Available to Print. Then, 

under Properties of the Field Selected Above, select a position from the drop-down list. 

5. To adjust the width of the column, adjust the number in the Width field. 

6. In the Heading field, enter a title for the selected field name. To create two-line headings, enter the first 

line, then press Ctrl + Enter. With the cursor on a new line, enter the second line of your heading. 

7. To print a label in each field of the selected column, enter text in the Left Label field. 

8. By default, PDS prints a blank line after each entry. To print without blank lines between each entry, 

select Try to Merge Lines Together. 

9. To save your settings, click Save/OK. 

 

Listing Report Margin Style 

The margin style sets the top, bottom, left, and right margins for the report. New margin styles can be inserted or 

existing ones changed or deleted. If an existing style is changed, it is changed for all reports using it. Each 

descriptive margin style name must be unique. 

To insert or edit a margin style: 

1. In the Listing Layout window, under Margin Style, click Edit Style. A dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select Margin Style Name. 

3. If you selected Insert Style, enter a unique Style Name. 

4. Enter or edit the top, bottom, left, and right margins. 

5. Click Save/OK, then Close. 

 

  



 

Letters and Statements 

There are several types of letters available for use in PDS programs such as corrections requests and church 

status/standing letters. You can also create or modify existing letters to suit your particular organization’s needs, 

including modifying the letterhead, letter date, inside address, closing, and margin styles. In addition, you can 

print various financial statements, such as billing statements, past due notices, and flex statements to send to 

members. You can locate letters under Reports. Statements are located under the financial report group. 

Locating Letter and Statement Reports 

On the main menu, click Reports. Under the Church/Inst. Reports report groups, double-click Letter/Statement 

Reports to expand the available reports. To select a report, click the report name and click Next to advance the 

Report Wizard. 

Setting the Letter Layout Window 

When you select a letter or statement report, the Report Wizard takes you to the Set the Letter Layout window. 

Use the options in this window to change the letterhead, letter date, inside address, closing, and margin styles. In 

addition, you can modify the text of the letter or statement using the editor. To view a sample of your report, click 

View Sample. 

 

Letterhead Style 

The letterhead style sets the layout and fonts for the letterhead. To select a style, click the drop-down list. New 

styles can be inserted or existing ones changed or deleted. If an existing style is changed, it is changed for all 

reports using it. Each descriptive letterhead style name must be unique. 

1. In the Set the Letter Layout window, under Letterhead Style, click Edit Style. The Edit Letterhead 

Style dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select a letterhead style name, enter a 

unique name in the Style Name field. 

3. To modify an existing letterhead or to create a new one, click Edit Text. This opens the text editor. 

4. Enter text and format as you want. To insert fields, click Insert Field. Then, double-click field names to 

insert them in the text. 

5. To insert a graphic, click Insert > Graphic Image. Select the file location and name. 

6. To close the editor, click OK. If you edited an existing style, the Saving Style dialog box indicates that 

the style is changed for all reports using the style. You have the option of entering a new style name. 

Click OK. This returns you to the Edit Letterhead Style dialog box. 

7. Select Print the Letterhead Inside the Margins or Print the Letterhead Outside of the Margins. To 

determine where to begin printing the letterhead, enter a number (in inches) in the Minimum Top 

Margin field. 

8. To save your settings, click Close. 

 

Letter Date Style 

The letter date style sets the format and position for printing a date in the letter. Examples of date formats include: 

 June 3, 2014 

 06/03/14 

 3 June 2014 

  

To insert or edit a letter date style: 

1. In the Set the Letter Layout window, under Letter Date Style, click Edit Style. A dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select a letter date style name. 



 

3. If you are setting up a new style, enter a unique name in the Style Name field. 

4. To select a date format, click the Format drop-down list. 

5. To select a font, click Set Font. Select the font, font style, size, effects, script, and color. Click OK. 

6. To set where the date will print on the letter, click the Position drop-down list and select Left Side, 

Center, or Right Side. 

7. To save your settings, click Save/OK, then Close. 

 

Inside Address Style 

You can use this style to customize the inside address, also known as the salutation. Examples of letter 

salutations include: 

 To Whom It May Concern: 

 Ladies and Gentlemen: 

 Attention (Name): 

 Dear (Name): 

  

To insert or edit a letter date style: 

1. In the Set the Letter Layout window, under Inside Address Style, click Edit Style. The Inside Address 

Style dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select an inside address style name. 

3. If you are setting up a new style, enter a unique name in the Style Name field. 

4. To modify an existing format or to create a new one, click Edit Text. This opens the text editor. 

5. Enter a salutation and format as you want. To insert fields, click Insert Field. Then, double-click field 

names to insert them in the text. 

6. To close the editor, click OK. If you edited an existing style, the Saving Style dialog box indicates that 

the style is changed for all reports using the style. You have the option of entering a new style name. 

Click OK. This returns you to the Edit Inside Address Style dialog box. 

7. To save your settings, click Save/OK, then Close. 

 

Text of the Letter 

Select Include COA Fields to have the COA fields included in the Church/Inst. letters. To modify the text of a 

letter or statement, click Modify the text of the letter. This opens the text editor. Insert new text, edit, and format 

text as you want. To save your changes, click OK. 

 

Closing Style 

The closing style customizes the letter’s closing. Examples of letter closings include: 

 Cordially, 

 Sincerely, 

 Warmest regards, 

 Yours very truly, 

  

To insert or edit a closing style: 

1. In the Set the Letter Layout window, under Closing Style, click Edit Style. A dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select a Closing Style Name. 

3. If you are setting up a new style, enter a unique name in the Style Name field. 

4. To modify an existing format or to create a new one, click Edit Text. This opens the text editor. 



 

5. Enter a closing, and format as you want. To insert fields, click Insert Field. Then, double-click field 

names to insert them in the text. 

6. To insert a signature bitmap, click Insert > Graphic Image. Select the file location and name. 

7. To close the editor, click OK. If you edited an existing style, the Saving Style dialog box indicates that 

the style is changed for all reports using the style. You have the option of entering a new style name. 

Click OK. This returns you to the edit dialog box. 

8. To save your settings, click Save/OK, then Close. 

 

Letter and Statement Margin Style 

The margin style sets the top, bottom, left and right margins for the report. New margin styles can be inserted or 

existing ones changed or deleted. If an existing style is changed, it is changed for all reports using it. Each 

descriptive margin style name must be unique. 

To insert or edit a margin style: 

1. In the Listing Layout window, under Margin Style, click Edit Style. A dialog box displays. 

2. To insert a new style, click Insert Style. To edit an existing style, select a margin style name. 

3. If you selected Insert Style, enter a unique Style Name. 

4. Enter or edit the top, bottom, left, and right margins. 

5. Click Save/OK, then Close. 

 

 

Labels and Envelopes 

After printing letters, statements, or other correspondence, use your PDS program to create standard and custom 

mailing labels and envelopes. You can also create specialized labels such as badges or tray tags. You can 

include bar codes on your envelopes or labels. Your PDS program helps you print addresses in a format 

acceptable to the United States Postal Service®. 

Locating Label and Envelope Reports 

On the main menu, click Reports. In one of the report groups, double-click Label/Envelope Reports to expand 

the available reports. To select a report, click the report name. 

 

Setting the Label and Envelope Layout Windows 

The Report Wizard includes a Set the Layout window. Use the options on this window to select a label, envelope, 

or return address style. You can also modify the address text and select options for how addresses and unlisted 

phone numbers print. To view a sample of the labels or envelopes, click View Sample. 

 

Label Style 

The label style stores multiple label formats, including some manufactured by Avery®. You can select a label style 

from the Style Name drop-down list. The label description displays beneath the style name. You can also set up 

custom label formats in the Label Style dialog box. 

Useful Information 

Use a margin setting of 0.000 to begin printing at the smallest margin for the printer selected. 

Useful Information 

The Label/Envelope Reports subgroup is not available in all report groups. 



 

To insert or edit a label style: 

1. In the Set the Label Layout window, beside Label Style, click Edit Style. 

2. To insert a new style, click Insert Style. To edit an existing style, select a label style name. 

3. Enter a unique name in the Style Name field. 

4. In the Description field, enter information about the label, such as its dimensions. 

5. Under Page Margins, enter the top, bottom, left, and right margins in inches. If the label stock you use 

is continuous form (pin fed or Dot Matrix), select Continuous Form. 

6. Under Label Dimensions, enter the height, width, and amount of space between rows and columns in 

inches. Enter the number of columns on the label stock. 

7. Click Save/OK and then Close. 

In the Copies field of the Set the Layout window, enter the number of copies you want to print. 

 

Useful Information 

The U.S. Post Office prefers that addresses be printed in postal format. Postal format is all uppercase 

letters with punctuation removed. To print the name and address in postal format, make sure the field 

names printed are preceded by the word “Postal.” For example, <Postal Fam Address Block>. 

 

Envelope Style 

The envelope style stores standard envelope sizes such as #9 (3 7/8” H X 7 1/2” W) or #10 (4 1/8” H X 9” W). You 

can select an envelope style from the Style Name drop-down list. The envelope dimensions display beneath the 

style name. You can also set up custom envelopes. 

To insert or edit an envelope style: 

1. In the Set the Envelope Layout window, beside Envelope Style, click Edit Style. 

2. To insert a new style, click Insert Style. To edit an existing style, select an envelope style name. 

3. Enter a unique name in the Style Name field. 

4. In the Description field, enter information about the envelope, such as its dimensions. 

5. Under Envelope Dimensions, enter the height and width of the envelope in inches. 

6. Under Text Margins, enter the top and left margins in inches. 

7. Click Save/OK and then Close. 

 

Return Address Style 

The return address style determines what and where the return address prints on the envelope. To select a 

Return Address style, click the Style Name drop-down list, and then click a style. 

To insert or edit a return address style: 

1. In the Set the Envelope Layout window, beside Return Address Style, click Edit Style. 

2. To insert a new style, click Insert Style. To edit an existing style, select a return address style name. 

3. Enter a unique name in the Style Name field. 

4. To modify the return address layout, click Edit Layout. 

5. Modify the text. To insert a data field, click Insert Field, select a field name, and click OK. 

6. At the bottom, click OK. 

7. Click Save/OK and then Close. 

 

Text of the Label or Envelope 

You can edit the text and layout of your label or envelope. 

1. In the Set the Layout window, click Modify the Layout of the Address Information to open the editor. 

2. Edit the text as necessary. To insert a data field, click Insert Field and select a field name. 

3. To save changes, click OK at the bottom of the window.  



 

Managing and Printing Keywords 

Keywords represent data that's used many times in the program. They simplify data entry and eliminate the 

possibility of spelling errors and inconsistent usage. They're saved in lists that are organized into categories, and 

you can add or delete terms from the lists as needed. 

To view keyword categories, on the menu at the top, click Keywords/Tables. 

To insert a new keyword: 

1. From the menu, click Keywords/Tables, then click the keyword list name. 

2. Click Insert <type>. 

3. Enter a name for the new keyword. 

4. Enter any other information. Press Tab or Enter to move to the next field or line. 

5. When you're finished, click Save/OK. 
 

To delete a keyword: 

 

1. From the menu, click Keywords/Tables, then click the keyword list name you want to delete. 

2. Click Delete <type>. 

3. Select each item you want to delete. 

4. Click Delete/OK. 

  

You may want to stop using a particular keyword. With the Combine command, you can delete a keyword and 

reassign another one to the records using it. 

To combine two keywords: 

 

1. From the menu, click Keywords/Tables, then click the keyword list name you want to edit. 

2. Click Combine <type>. 

3. In the left column, select the keyword you want change. 

4. In the right column, select the keyword you want to keep. 

5. Click Add to List of Changes Below. 

6. Repeat steps 3 through 5 for any other keywords you want to combine. 

7. To process the list of changes to be made, click Combine/OK. 

Printing Keyword Lists 

After setting up a keyword list, you can print a copy of it for reference or to give to coworkers. From the menu, 

select the keyword list you want to print, and click Print. 

  

Note 

If you delete a keyword, it's removed from the list and all windows where it's used. 

All other users must exit the program before you continue. 

Be Careful 

All other users must exit the program before you continue. 



 

Keyword Descriptions and Locations 

Keywords represent data you use throughout DioView. You can add them on church records. 

Keyword Categories 

 Type of Institutions — Types of institutions and divisions in your diocese, such as parishes and schools. 
You can select these on the Church/Inst. Detail Address window. 

 Church/Institution Keywords — Miscellaneous keywords that you can associate with parishes in your 
diocese. This can be any information that isn't covered by other fields. 

 City/State Names — Cities/states, country codes, area codes, and ZIP/postal codes you can use in 
address fields. The Default City/State you select is automatically inserted when you click or tab to a blank 
City/State field. 

 Phone Description Names — Types of phone numbers people use, like "Home" and "Cell". 

 Position Types — Employment positions for parish/institution contacts, like "Office Manager", 
"Accountant", and "Bookkeeper". 

 Regions — Regions for the institutions in your diocese, such as "Parish", "Deanery", and "Vicariate". 
Select these on the Church/Inst. Detail Address window. 

 Main Languages — Predominant languages spoken by parishes or contacts, like "English", "Spanish", 
and "French". 

 Statistic Periods — Time periods to keep track of statistics for your parishes or institutions, such as 
dates of fiscal years and quarters. 

 Statistic Types — Statistics you keep track of for each parish or institution. For example, the total 
number of families in the parish. 

 

Backing Up, Restoring, and Moving Data 

Learn how to back-up and protect your files from being lost to unwanted events such as a natural disaster or a 

database corruption. Also, learn how to restore data from an earlier backup or move archived files to another 

computer. 

 

The Basics of Backing Up Data 

The most valuable component of your computer system is its stored data. Guarding it against loss due to a 

natural disaster or a database corruption is important, especially when you must access your data as quickly as 

possible. 

We recommend backing up your data each day and storing it in a secure, off-site location. 

Planning a Backup Strategy 

To help you plan a backup strategy, we recommend the following: 

 Commit to a plan that includes a schedule for making daily or weekly backups. 

 Test your backup process and restore your data monthly or quarterly. 

 Store at least one month's worth of data on multiple sets of backup media for extra protection. 

 Keep a log to record dates and details about your backups. Include when the backup happened, who 

made the backup, and which backup set was used. 

 Each month, run the Test the Program and the Fix Data Discrepancies processes to identify and repair 

small problems. 



 

About PDS Backups 

You can create backups of your data both automatically and manually. With the Automatic Backup feature, your 

current data is backed up on the days you select. You can also create a manual backup of your data at any time. 

About Internal Archive Folders 

You can manage the number of automatic and manual backup files stored in internal archive folders on your hard 

drive. Your hard drive contains the following internal archive folders:  Weekly, Monthly, Quarterly, and Yearly. 

When a backup file is created, it's stored in the Weekly folder. Depending on your automatic backup setting, the 

old backup files are automatically moved or deleted when a backup is complete. 

The files are moved from one folder to another in the following ways: 

 Weekly to Monthly 

 Monthly to Quarterly 

 Quarterly to Yearly 

About Data Compression 

The backup process compresses your data files into a compact archive. Compression reduces the file size and 

the amount of time required to copy the files to a disk. Backup files have a .pds extension. Although standard 

compression programs can read the backup files, we recommend using the integrated restore feature of the PDS 

program to restore lost or damaged data. 

Rotating Backup Sets 

We don't recommend using the same set of storage media each time you create a backup. To reduce or eliminate 

the chance of data discrepancies and corrupt data, use different sets every time you back up your data. 

For example, if you back up your data each Friday, use at least four backup sets in order to provide better 

protection. Label your flash drives or other media Friday 1, Friday 2, Friday 3, and Friday 4. 

 

Performing the First Backup 

Before you perform your first backup, you must perform the actions in the following list. For more information 

about creating backups, see Backing Up Data Manually. 

 Review the settings on the Backup Current Data window. Specifically, make sure that you select the drive 

where you want to create the backups. 

 Make sure that you have plenty of disks to complete the backup. High-capacity drives, such as ZIP 

drives, can create the backup on one disk. However, high-density diskettes can require multiple disks. 

PDS backup files require at least 0.5 MB of free space. 

 Format and label all disks. To verify that a disk is ready for use, copy a small file to it. If the computer 

does not report an error, the disk is ready for use. For information about formatting disks, see your 

operating system documentation. 

  

When you run the first backup, you are prompted to delete the existing files from the set. 

 To delete the indicated files from all disks in the backup set, click Yes. 

 To keep the indicated files, click No and use a different disk. 

 To stop the backup, click Cancel. 

 



 

Backing Up Data Manually 

When you create manual backups, you can store the backup files on disks, servers, or network folders. PDS also 

stores each manual backup file in an internal archive folder. 

Before you back up your data, make sure: 

 You have enough storage media to complete the backup. PDS backup files require at least 0.5 MB of free 

space. 

 You disable your computer's Hibernate, Sleep, or Stand By options. 

 All PDS users are logged out. 

 Your backup media is preformatted. 

When backing up your data: 

 Do not shut down or turn off the power to your computer. 

 Do not log off of the computer at any time during the backup process. 

     

To back up your data manually, on the menu at the top, click Backup/Restore > Backup Current Data. Make 

your selections, then click Start Backup. 

 

Backing Up Data Automatically 

With the Automatic Backup, you can set your PDS program to automatically perform backups on selected days. 

 

 Install PDS on the computer or server that stores the data. 

 Make sure the computer/server is powered on at the time when the automatic backup is scheduled to run. 

 Close all PDS programs installed on other computers. 

 Enter your email address in the License Information window. If the program can't complete the automatic 

backup process, you receive an email notification. 

  

The Automatic Backup feature is not a substitute for manual backups. We recommend creating manual backup 

files of your data regularly. 

  

Scheduling Automatic Backups During Off-Hours 

If you want to run your backups after midnight on the scheduled backup day, you can set up a Windows® 

scheduled task. This isn't required, but otherwise the PDS Automatic Backup feature can only run when you open 

your program on the scheduled backup day. 

If you create backup files for multiple PDS programs, you must schedule a task for each program. Make sure that 

the start time for each program is at least 15 minutes apart from any other previously scheduled task start time. If 

your PDS program is installed on a network, you must use the shared network name. 

 

Before you set up automatic backups, you must: 

Tip 

If you use  your backups are automatically made each night and stored on the  OnDemand, 

OnDemand server, so you do not need to schedule automatic backups. 

Useful Information 

The following procedure is for Microsoft® Windows 8® users. For information on creating  

scheduled tasks in earlier versions, see the help documentation for your version. 

http://www.c-sharpcorner.com/UploadFile/6cde20/create-schedule-task-in-windows-8/
http://www.c-sharpcorner.com/UploadFile/6cde20/create-schedule-task-in-windows-8/
http://www.c-sharpcorner.com/UploadFile/6cde20/create-schedule-task-in-windows-8/


 

To create a scheduled task: 

1. Locate the Windows Task Scheduler on your computer. 

2. In the Task Scheduler window, click Create Basic Task. The Create Basic Task Wizard displays. 

3. Enter a name for the scheduled task, and click Next. 

4. In the Task Trigger window, select how frequently to create automatic backups, and click Next. 

5. If necessary, select the time, day, or month when you want the update to occur, and click Next. 

6. In the Action window, select Start a program, and click Next. 

7. In the Start a Program window, click Browse, select the PDS program application you want to create a 

scheduled task for, and click Open. The program path displays in the Program/script field, and should 

have an .exe extension. 
 

Useful Information 

If the information does not display in the Program/script field, right-click the PDS desktop icon, 

and click Properties. Copy the information that displays in the Target field and paste it in the 

Program /script field of Windows Scheduler. At the end of the text, enter "BACKUP". 
 

8. In the Add arguments field, enter "BACKUP". Click Next. 

9. Review the information, and click Finish. 

  

Scheduling Automatic Backups in PDS 

Once you create a scheduled task in Windows, set an automatic backup schedule in your PDS program. You can 

also set up the Automatic Backup process to run without scheduling a Windows scheduled task. 

To schedule an automatic backup: 

1. On the menu at the top, click Backup/Restore > Setup Automatic Backup Options. 

2. Select the day(s) of the week that you want an automatic backup to run. 

3. To select the internal archive folder where you store the automatic backup, click Browse. To use the 

default backup folder, leave this field blank. 

4. If your internal archive folder is on another computer, enter the UNC reference to it. 

 

5. Select a level of protection for your internal archive files. See more about these options below. 

6. Click Close. 

About the Minimum Option 

If you select the Minimum option, one backup file is stored in each internal archive folder. 

 

Folder Name 
Minimum Number of Backup Files 

in Each Folder 

Amount of Time Before Backup is 

Discarded or Moved 

Weekly 1 backup file 7 days 

Monthly 1 backup file 30 days 

Quarterly 1 backup file 90 days 

Yearly 1 backup file 365 days 

 

About the Moderate Option 

If you select the Moderate option, several backup files are stored in each internal archive folder. 

Useful Information 

This prevents problems for multiple workstations using different drive letters to access the shared  
folder. For example, enter "\\ServerName\ShareName" instead of "F:\Backup". 



 

 

Folder Name Minimum Number of Backup Files 

in Each Folder 

Amount of Time Before Backups are 

Discarded or Moved 

Weekly 5 backup files 21 days 

Monthly 2 backup files 60 days 

Quarterly 3 backup files 270 days 

Yearly 3 backup files 1095 days 

 

About the Maximum Option 

If you select the Maximum option, the maximum number of backup files are stored in each internal archive folder. 

 

Folder Name Minimum Number of Backup Files 

in Each Folder 

Amount of Time Before Backups are 

Discarded or Moved 

Weekly 10 backup files 28 days 

Monthly 4 backup files 90 days 

Quarterly 6 backup files 360 days 

Yearly 7 backup files 2555 days 

 

 

Restoring Data from a Prior Backup 

Sometimes, restoring data is a better option than fixing numerous incorrect entries. 

 

 Restore data from a backup file. For example, if you enter a large amount of incorrect data, you can 

restore a previous version of the data and enter the correct information. 

 Move data to a newly purchased computer. 

 Replace files lost due to hard drive failure or file damage. 

    

You cannot restore backup data from read-only media such as CD-ROM disks. To restore data included on read-

only media, copy the file to a rewritable drive, and then clear the Read-only option in the Microsoft Windows file 

properties dialog box. For more information, see Microsoft help. 

 

 
 

On the menu at the top, click Backup/Restore > Restore Data from a Prior Backup. Make your selections, and 

click Next. When you're ready, click Start Restore. 

     

With this process, you can: 

Tip 

If you use     need to restore a previous backup, contact PDS Support at 1-877-737- OnDemand and 4457. 

Note 

When you restore from a backup, you overwrite data entered after the backup was created. 

https://support.office.com/en-us/article/What-is-Protected-View-d6f09ac7-e6b9-4495-8e43-2bbcdbcb6653


 

Advanced Restore Options 

Backup files contain multiple smaller files. When you complete a standard restore process, all the smaller files are 

restored. 

In the Advanced Restore Options window, you can view the smaller files included in the backup file, and select 

individual files you want to restore. If you select a .db file, any other files that share the file name are automatically 

selected. Under Reports and Styles, the reports added by users display. 

 

 

Moving Archived Files to Another Computer 

With this process, you can move the active data file and the internal archive data from your hard drive to another 

computer. 

How Is This Different From a Backup? 

A backup is a like a snapshot at a specific point in time. When you restore a backup to a new computer, it 

restores the data exactly as it was when that snapshot was taken. However, normal backups don't restore any 

history of what was stored in the archive folders (Backup\Week, \Month, \Quarter, and \Year), so a normal 

restore doesn't recover any older backups. 

This process restores not only the data, but the old backups in the archive folders as well. 

Moving Files to Another Computer 

 

First, you need to save archive files from your old computer. 

To save archive files: 

1. On the menu at the top, click Backup/Restore > Move Data to Another Computer. 

2. Select an archive method. 

3. Select or enter the drive or folder where you want to save your archive files. 

4. Click Save Archive Files to Disk. 

  

Before loading archive files to a new computer, you must set up the computer. Install the PDS program. When 

you run PDS for the first time, the Registration/System Information Wizard displays. Select New User to create an 

empty data file. 

To load archive files: 

1. On the menu at the top, click Backup/Restore > Move Data to Another Computer. 

2. Select an archive method. 

3. Select or enter the drive or folder you want to load your archive files from. 

4. Click Load Archive Files From Disk. All of the internal archive files from the backup drive are 

decompressed, and the current data is restored. 

 

Warning 

Do not use Advanced Restore Options unless you understand the database. If you restore an  

incorrect set of files, use the PDS Rescue program to restore all your files. 

Note 

With this process, you must enter your registration code on the new computer. 



 

Using Scheduled Tasks in OnDemand 

 
 

With Scheduled Tasks for OnDemand, you can automatically synchronize your program data with another PDS 

program at a specified time. 

 Church Office users can schedule uploads and synchronizations to DioOffice. 

 DioOffice users can schedule uploads and synchronizations to Church Office. 

 Ledger users can schedule uploads and synchronizations to DioView. 

This way, you comply with diocesan requirements without having to manually run this task. 

 To add a new scheduled task: 

1. On the OnDemand desktop, double-click the Schedule Tasks icon. 

2. On the Scheduled Tasks tab, click Add. 

3. In the Schedule a Task window, select a task. 

4. Enter the time and select the day(s) for the task to run. The servers are set for Eastern Standard time. 

Click Adjust to enter your local time. 

 

5. Click OK. The task displays on the Scheduled Tasks tab. 

  

At the time you scheduled, OnDemand will start your program and run the task. On the Task Log tab, you can 

view the dates and times your tasks were scheduled, and if applicable, when they started and ended. 

  

  

Useful Information 

This feature is only available for OnDemand clients. 

Note 

All users must be logged out for scheduled tasks to run. Select a time when no one is working in  
OnDemand, such as 10:00 p.m. 



 

Testing the Program 

With this process, you can verify that data files are in good shape. The program and data files can develop 

discrepancies as a result of improper system shutdown, operating system failure, hard drive failure, computer 

virus infection, network failure, or other computer complications. To minimize this risk, back up your data 

regularly. 

We recommend periodically running this process to test for data discrepancies, missing files, or configuration 

issues. On the menu at the top, click Test/Fix > Test the Program. A dialog box displays stating what parts of the 

program were tested. 

If problems are found, do not operate the program or enter data until you resolve them. 

To resolve problems found when testing the program: 

1. Click Close, and exit the entire program. If you use a multiuser system, all other users must exit the 

program. Close all other programs running on the computer. 

2. Use the Microsoft® Check Disk utility to check your computer's hard drive for errors. 

 

3. Make a backup of your data to new storage media. 

4. Reinstall the most recent version of the program. 

5. After the program is reinstalled, open it and retest it. 

6. Once the Test the Program process passes without errors, run the Fix Data Discrepancies process to 

verify that your data is correct. 

 

Fixing Damaged Data 

With this process, you can verify that the program does not contain data discrepancies. The program and data 

files can develop discrepancies as a result of improper system shutdown, operating system failure, hard drive 

failure, computer virus infection, network failure, or other computer complications. To minimize this risk, back up 

your data regularly. 

 

To fix data discrepancies: 

1. On the menu at the top, click Test/Fix > Fix Damaged Data. 

2. If the "index out of date" error displays, select Reindex Tables. 

3. To remove empty space in the data tables, select Pack Tables. 

4. Click Fix Data. After the process is finished, a summary report displays. 

5. When you're finished, click Close. 

  

Warning 

If hard drive errors are found, immediately contact your parish's computer technician. Otherwise,  
continue to step 3. 

Warning 

This process can repair some small problems with the data. If severe discrepancies exist, you can  

restore data from a recent backup. If this happens, however, all information entered since the last  

backup is lost. 



 

Online Resources and Help Menus 

The Online Resources menu includes links to PDS web pages and online services. The Help menu gives links to 

Help topics and the version number of your software. 

 

PDS Services 

This section includes links to services available from PDS. 

Your Dealer Web Page — Visit your dealer's web page for the latest product news, and view details about 

the PDS Preferred Client Program. This only displays if you entered your dealer's contact name and web 

address in the License Information window. 

E-Mail Your Dealer — Send an email to your dealer. This only displays if you entered your dealer's name 

and email address in the License Information window. 

Preferred Client Program — If you did not enter your dealer's information in the License Information window, 

the Preferred Client Program menu item is listed instead of Your Dealer Web Page and E-Mail Your 

Dealer. The Preferred Client Program provides a wide variety of offers, services, and discounts through PDS. 

If you prefer to display your dealer contact links instead, set up your dealer's contact information in the 

License Information window. 

PDS Training Courses — View details about the comprehensive training offered by PDS. 

Forms and Supplies — See information about quality forms, supplies, and compatible products such ACS 

Check Reader. 

More Services — View details about other services provided by PDS such as CASS™ certification, custom 

reports, and data transfers. 

 

PDS Client Support 

This section has links to helpful sites and PDS Support. 

Support Site — Go to the PDS client support site 24 hours a day for assistance and help. Some features on 

this site are only available to clients enrolled in the Preferred Client Program. 

Check for Program Updates — We periodically post updates for programs on our website. You can 

download, install, and update the latest data for your PDS program. For more information, see Checking for 

Program Updates. 

Downloads — Go to the PDS website to download PDS updates, demos, or video presentations. 

Connect with Support — Have a support representative take control of your desktop and manually help you 

with your program issues. A support representative will tell you when this option needs to be used. 

E-Mail Support Now — Send questions and receive support through email. If you aren't enrolled in the 

Preferred Client Program, email support is available for an additional cost. 

 

Checking for Program Updates 

Use the Check for Program Updates option to check the PDS website for available updates to your program. If 

you're on a network, this options also checks other computers for updates. 

Before you check for program updates: 

 If you are running Windows® 2000 or higher, log in as an administrator. 

 Disable anti-virus software. 

 If you're experiencing problems with your database, test the program and fix those issues. 

 Back up your data. 



 

Tip 

To see who's in DioView, on the File menu, click List of Users Currently in Program. 

 All other users must exit the program. If you share data between PDS products, all users must exit those 

programs as well. 

 

 

 

 

To update your PDS program: 

1. On the menu at the top, click Online Resources > Check for Program Updates. 

2. Make sure your email address is correct and click Check. If a newer version is available, the PDS 

website displays. If no updates are available, your program is up-to-date. 

3. To start the update, click Yes. 

4. Click OK once the update finishes, and wait for the program to restart. 

5. If there are multiple computers in your office, update each computer on the network that uses the PDS 

program. Open the PDS program on each computer. A dialog box displays stating there's a newer 

update available. To update the program, click Yes. 

 
 

If you're on a network, the program update process uses the proxy server values set up in the web browser. If you 

experience trouble using the update process, ask your network administrator to set up or review the information 

for the proxy address, port, user ID, and password. 

 

Warning 

Once the program restarts, a message displays indicating that the program is being updated to the latest 

version. It can take up to an hour to update the database. Wait for the program to completely load.  

DO NOT press Ctrl+Alt+Delete, even if you think the program has locked up or the Task Manager reports 

that the program is not responding. If you interrupt the update, you must use the Rescue program to restore 

from your previous backup and restart the program update. 

 

Help Menu 

The Help menu provides assistance in the following areas: 

Contents — Displays the Help topics. You can also view Help contents from any window by pressing F1 on 

your keyboard. You can browse the table of contents, or search for topics. 

 

What is This? — Click What is This? or press Ctrl + F1 to display the What is This? cursor. Then, click a 

button, tab, or field with the cursor to display context-specific Help. 

View User Guide — Displays the online user guide. Search for topics to learn more and see program steps. 

About PDS Financial Viewer — View information about your program, such as: 

 The program version 

 The program path 

 The location of the data 

 Your computer name 

 Your site number 

 Your user name 

 PDS copyright dates 

 Available memory and system resources

Useful Information 

If your program fails to restart, download the update from the PDS Downloads website. 

Useful Information 

You must have Microsoft Internet Explorer® version 4.0 or higher to view the HTML Help files. 



 

QuickBooks Interface for PDS DioView 

Quick Start Guide 

QuickBooks® Interface for PDS DioView transfers information stored in a QuickBooks ledger to a diocesan 

database through a secure web service. The information contains the monthly totals for accounts. It does not 

include any bank account or employee information. The information can be encrypted and compressed 

automatically for even greater security. 

 

 

Installation 

To begin the installation wizard, insert your program CD. 

However, if you downloaded the program from the web, do the following before proceeding through the wizard. 

If you downloaded your program from the web… 

1. On your keyboard, hold the Windows key and press X. 

2. Click Run. 

3. In the Open field, enter the location where you saved the program. For example: C:\SetupQB. 

4. Windows Vista and Windows 7 Users: Start the setup with administrative privileges. Right-click 

DioQBSetup.exe and click Run as administrator. Other users can double-click DioQBSetup.exe. 

To proceed through the wizard: 

1. Click Next. The Setup window displays. 

2. Select a location to install this program. The default path is C:\PDSDioQB. 

3. Click Next. 

4. When the installation is complete, click Finish to exit the setup. 

  

The program is now installed on your computer. When you open QuickBooks, DioView automatically connects to 

the program. 

 

  

Note 

PDS DioView is compatible with QuickBooks Premier Edition, QuickBooks Pro 2003, Pro 2004, Pro  

2005 , Pro 2006, Pro 2007, Pro 2008, Pro 2009, and QuickBooks Enterprise Solutions. It is not  

compatible with QuickBooks Basic. 



 

Using QuickBooks 

Windows 7 Users: Right-click the QuickBooks icon and select Run as administrator. You're prompted to 

confirm that you want DioView to have access to your data. Depending on your version of QuickBooks, you can 

select the following: 

 Yes, This Time — This window displays each time you enter the program. 

 Yes, Always — This window does not display again. We recommend this selection. 

 

You do not need to select the check box to view Social Security numbers. PDS does not transmit this information. 

To start the DioView transfer: 

1. On the File menu, select DioView: Transfer Data to Diocese. 

2. Select Yes, This Time or Yes, Always. 

3. The transfer wizard displays to help you set up your transfer to the diocesan web server. 

4. On the first window, enter your church information and web server. Your diocese provides this to you. 

5. To test the values, click Test the Web Service Connection. The program saves your values. 

6. Click Next. The Gather Information window displays. 

The Gather Information Window 

This window displays the program’s progress as it gathers information from a number of sources: 

 It loads the diocesan master chart of accounts (COA), the list of valid accounts the diocese has set up. 

 It loads the list of accounts from your QuickBooks data. 

 It attempts to match your accounts to the master COA. If you selected Ignore Department Codes on the 

previous window, the process ignores the department code while performing the match. 

 The program performs a mapping process to locate any mapping problems that exist in the data. 

The Mapping Window 

The mapping window only displays if your diocese requires mapping changes. If this window does not display, 

skip this section. This is where you can customize maps from your accounts to the diocesan accounts (detail 

accounts only). The program has already mapped accounts that had the same account number as a master COA. 

It also saves mapping from the last time you ran this process. 

About the window 

 Your unmapped accounts display by default. However, you can also display all accounts. 

 A grid displays church detail accounts and descriptions of any problems. It also maps the diocesan 

account. 

Potential problems 

 The program cannot map a diocesan account to the church account. 

 The program finds a matching diocesan account that is not the same type as the church account. 

Solutions 

 The program checks that the account types match in both the church account and the diocese account. 

For example, you cannot map an asset account to an income account. 

 To resolve a problem, select a diocesan account from the drop-down menu to map to the church account. 

You can only select a master COA account. It must match the church account type. 

You must resolve all problems before you can upload data to the diocese. When corrected, the Problems column 

displays as Fixed. You can override the current mapping, if necessary. 

 



 

Overriding the Current Mapping 

Example: Church account 0500 is mapped to diocesan account 0500. 

It should be mapped to diocesan account 0559. 

  

The following procedure outlines how to map to another account using the previous example. 

To map to another account: 

1. Select Show The Mapping of All of the Detail Church Accounts to Diocesan Accounts. 

2. Find account 0500. 

3. From the Map to Diocesan Account drop-down list, select account 0559. 

4. To print a list of mapping, click Print. You can cancel at any time and save your work to this point. 

  

Once you resolve all problems, click Next to proceed to the Transfer window. 

The Transfer Window 

To upload the month totals to the diocese, click Start Transfer. This window displays the progress of the transfer. 

It also displays potential problems. 

When the transfer is complete, the program notifies you that your data successfully uploaded. Any errors display 

as well. 

To print the contents of the Current Status box, click Print. To exit the process, click Finish. 

 


